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Copyright Notice 
Copyright© 1999 by Megger. All rights reserved. 

 
Disclaimer Notice 
The information contained in this manual is believed to be adequate for the intended use of the product. 
If the product or its individual instrument are used for purposes other than those specified herein, 
confirmation of their validity and suitability must be obtained from Megger. Refer to the warranty 
information included at the end of this instruction manual. Specifications are subject to change without 
notice. 
 
Warranty 
Products supplied by Megger are warranted against defects in material and workmanship for a period of 
one year following shipment. Our liability is specifically limited to replacing or repairing, at our option, 
defective equipment. Equipment returned to the factory must be shipped prepaid and insured. This 
warranty does not include batteries, lamps, or other expendable items, where the original manufacturer's 
warranty shall apply. We make no other warranty. The warranty is void in the event of abuse (failure to 
follow recommended operating procedures) or failure by the customer to perform specific maintenance 
as indicated in this manual. 
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PROPRIETARY INFORMATION NOTICE 

This document contains information proprietary to Megger. All rights are 
reserved. 

No part of this document may be reproduced, transmitted, processed or 
recorded by any means or form, electronic, mechanical, photographic or 
otherwise, nor be released to any third party without the express written consent 
of Megger. 

Megger Software End User License Agreement  

NOTICE TO USER: THIS IS A CONTRACT. BY INSTALLING/USING 
THIS PRODUCT YOU ACCEPT ALL TERMS AND CONDITIONS OF 
THIS AGREEMENT. If you do not agree with the terms and conditions of this 
Agreement, return the software, unused, along with the rest of the package, to 
Megger. This package contains software and related explanatory written 
materials. The term Software shall also include any upgrades, modified versions, 
updates, additions and copies of the Software licensed to you by Megger. Megger 
grants you a nonexclusive license to use the Software and Documentation, 
provided you agree to the following: 

Use of the Software – You may – 

Install the software on any computer within your company. 

Make one backup copy of the Software. 

Copyright – The Software is owned by Megger, and its structure, organization 
and code are the valuable trade secrets of Megger. The Software is also protected 
by United States Copyright Law and International Treaty provisions. You must 
treat the Software just as you would any other copyrighted material, such as a 
book. You may not copy the Software or the Documentation, except as set forth 
in the Use of the Software section. Any copies that you are permitted to make 
pursuant to this Agreement must contain the same copyright and other 
proprietary notices that appear on or in the Software. You agree not to modify, 
adapt or translate the software. You also agree not to reverse engineer, 
decompile, disassemble or otherwise attempt to discover the source code of the 
Software. 

Transfer – You may not rent, lease, sublicense or lend the Software or 
Documentation. You may, however, transfer all of your rights to use the 
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Software to another person of legal entity provided that you transfer this 
Agreement, the Software, including all copies, updates and prior versions, and all 
Documentation to such person or entity, and that you retain no copies, including 
copies stored on a computer.  

Limited Warranty – Megger warrants that the SOFTWARE will perform 
substantially in accordance with the accompanying written materials for a period 
of one year from date of receipt. Any implied warranties on the SOFTWARE are 
limited to one year. 

Customer Remedies – Megger and its suppliers’ entire liability and your 
exclusive remedy shall be, at Megger option, either (a) return of the price paid, or 
(b) repair or replacement of the SOFTWARE that does not meet this Limited 
Warranty and which is returned to Megger with proof of purchase. This Limited 
Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, 
or misapplication. Any replacement SOFTWARE will be warranted for the 
remainder of the original warranty period or thirty (30) days, whichever is longer. 

No Other Warranties – To the maximum extent permitted by applicable law, 
Megger and its suppliers disclaim all other warranties, either express or implied, 
including, but not limited to implied warranties of merchantability and fitness for 
a particular purpose, with regard to the SOFTWARE, the accompanying written 
materials, and any accompanying hardware. 

No Liability for Consequential Damages – To the maximum extent 
permitted by applicable law, in no event shall Megger or its suppliers be liable for 
any damages (including without limitation, special, incidental, consequential, or 
indirect damages for personal injury, loss of business profits, business 
interruption, loss of business information, or any other pecuniary loss) arising 
out of the use of or inability to use this product, even if Megger has been advised 
of the possibility of such damages. In any case, Megger and its suppliers’ entire 
liability under any provision of this agreement shall be limited to the amount 
actually paid by you for the SOFTWARE. 

Megger Technical Support 

In the event that the PoerDB Lite software appears defective or if you need 
assistance in the operation of the  PoerDB Lite software, call the MEGGER 
SUPPORT DEPT at (610) 676-8500. The Megger Support Dept will determine 
the necessary support to correct the problem. 
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CUSTOMER FEEDBACK 

We listen to our customers very seriously when they express interest in or 
suggest new or modified features. Please feel free to call, e-mail, fax, or write 
with any comments or suggestions you may have. We can be contacted at the 
following: 

By Phone: 610-676-8500  

By Fax:  610-676-8610 

By Website: www.megger.com 

By Mail: 

Megger 
Valley Forge Corporate Center 
2621 Van Buren Avenue 
Norristown, PA 19403 U.S.A. 

IMPORTANT! 

Megger periodically provides updates of software. See our web site www.megger.com 
to obtain these download updates. 

SEE ALL OF OUR PRODUCTS, APPLICATION NOTES, FAQ’s BY 
PRODUCT, AND LOCAL REP INFORMATION ON THE WEB AT:  
www.megger.com 

AUDIENCE 

This manual is written for technical personnel who are familiar with the various 
measurements performed by a TTR and have a general understanding of their use and 
operation. Such personnel should also be thoroughly familiar with the hazards associated 
with the use of this equipment and should have received proper safety training. 
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MANUAL CONVENTIONS 

This manual uses the following conventions: 

Bold indicates emphasis or a heading. 

Arial Bold denotes the use of a screen button (i.e. click the TTR button). 

Ctrl+Enter indicates that to perform the function, press both keys 
simultaneously (i.e. Ctrl+Enter indicates that you hold-down the Control (Ctrl) 
key while simultaneously striking the Enter key). 

NOTE: is used to set off important information from the rest 
of the text. 

A WARNING symbol alerts you to a hazard that may result 
in equipment damage, personal injury, or death. Carefully 
read the instructions provided and follow all safety 
precautions. 

 

A CAUTION symbol alerts you that the system may not 
operate as expected if instructions are not followed.  
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1 
Introduction 

Receiving Instructions 

Check the equipment received against the packing list to ensure that all materials 
are present. Notify Megger of any shortage. Telephone 610-676-8500. 

Examine the instrument for damage received in transit. If any damage is 
discovered, file a claim with the carrier at once and notify Megger or its nearest 
authorized sales representative, giving a detailed description of the damage. 

This instrument has been thoroughly tested and inspected to meet rigid 
specifications before being shipped. It is ready for use when set up as indicated 
in this manual. 

General Information 

The Three-Phase TTR®310 Test Set is fully automatic, self-checking, self-
calibrating,  
menu-driven unit. The test set measures the turn ratio, phase shift, and excitation 
current of power, distribution, and instrument transformers. A “-47” suffix 
added to the catalog number denotes a 230-V input power supply, rather than 
the standard 120-V supply. The test set is a portable instrument housed in a 
sturdy plastic case with lid and carrying strap. The inside bottom half of the case 
is nickel coated. A canvas carrying bag is supplied to hold all accessories. 

The test set can be used to test single-phase and three-phase transformers, both 
with and without taps in accordance with the requirements of the IEEE 
C57.12.90 – 1997 standards. For three-phase measurements, the test set is 
connected to all Three-Phases of the transformer to be tested. The TTR310 lead 
selection circuitry permits automatic measurement of all phases without changing 
connections. This feature eliminates the need to refer to hook-up charts when 
testing three-phase transformers. Turn ratio, phase shift and excitation current 
readings are displayed on a large LCD. Transformer excitation current as well as 
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phase shift angle helps to detect transformer shorted turns or an unequal number 
of turns connected in parallel. Operating condition (error) messages identify 
incorrect test connections, abnormal operating condition, or winding problems. 
Test results can be saved, printed out on an optional printer, or uploaded to a 
personal computer (PC). 

Features include: 

 Fully automatic operation. 

 Self-checking at power-up. 

 Self-calibration at each measurement. 

 User-friendly, menu-driven operation. 

 Test turn ratio, phase shift (in both degree and centiradian), and 
excitation current. 

 Easy measuring of regular windings, tertiary windings, and CTs. 

 Storage capacity for up to 200 tests for retrieving, printing out, or 
uploading to a PC. 

 Saving up to 9 custom transformer settings for faster and easier testing. 

 Checking reverse polarity at start of each test. 

 External printer records test data. 

 External PC or laptop can be connected instead of a printer to transfer 
test results and to provide full transformer test report. 

 Quick test mode provides the fastest testing of a transformer. 

 Three excitation test voltages: 80 V, 40 V, and 8 V. 

 Testing to ANSI, IEC, and Australian standards. 

 Leads marked to ANSI, IEC, and Australian standards. 

 Choice of six languages. 

 Large, easy-to-read LCD shows alphanumeric data 

 Meets the requirements of both the European EMC and Low Voltage 
Directives. 

 Trouble-free operation in switchyards under electrostatic and magnetic 
interference conditions. 
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2 
Safety 

The test set and the specimen to which it is connected are a possible source of  
high-voltage electrical energy and all persons making or assisting in tests must 
use all practical safety precautions to prevent contact with energized parts of the 
test equipment and related circuits. Persons actually engaged in the test must 
stand clear of all parts of the complete high-voltage circuit, including all 
connections, unless the test set is  
de-energized and all parts of the test circuit are grounded. Persons not directly 
involved with the work must be kept away from test activities by suitable 
barriers, barricades, or warnings. 

Treat all terminals of high-voltage power equipment as a potential electric shock 
hazard. There is always the possibility of voltages being induced at these 
terminals because of proximity to energized high-voltage lines or equipment. 
Always disconnect test leads from power equipment before attempting to 
disconnect them at the test set. The ground connection must be the first made 
and the last removed. Any interruption of the grounding connection can create 
an electric shock hazard. 

This instrument operates from a single-phase power source. It has a three-wire 
power cord and requires a two-pole, three-terminal, live, neutral, and ground type 
connector. The voltage to ground from the live pole of the power source must 
be within the following rated operating voltage: 

For Cat. No TTR310  120 V ±10%, single phase, 50/60 ±2 Hz 

For Cat. No. TTR310-47 230 V ±10%, single phase, 50/60 ±2 Hz 

The neutral pole must be at ground potential. Before making connection to the 
power source, determine that the instrument rating matches the voltage of the 
power source and has a suitable two-pole, three-terminal grounding type 
connector.  

The power input plug must be inserted only into a mating receptacle with a 
ground contact. Do not bypass the grounding connection. Any interruption of 
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the grounding connection can create an electric shock hazard. Determine that the 
receptacle is properly wired before inserting the plug. 

For test sets energized with 230 V input, the neutral terminal of the input supply 
cord (white or blue lead) must be connected to the neutral pole of the line power 
source. The ground terminal of the input supply cord (green or yellow/green 
lead) must be connected to the protective ground (earth) terminal of the line 
power source. The black or brown cord lead is the live (hot) lead. 

To avoid electric shock hazard, operating personnel must not remove the 
instrument from the case. Any repair or component replacement must be 
performed by qualified service personnel. 

The control circuits of the instrument are protected by two mains circuit fuses. 
These fuses are replaceable by the operator. To avoid electric shock and fire 
hazard, use only the fuse specified in Section 3, Specifications, that is identical in 
respect to type, voltage rating and current rating. Refer to the Fuse Replacement 
procedure in the Service section. 

 

WARNING 
Before replacing the fuses, disconnect the power input 
plug from the live power source. 

 

Megger has made formal safety reviews of the initial design and any subsequent 
changes. This procedure is followed for all new products and covers areas in 
addition to those included in applicable standards. Regardless of these efforts, it 
is not possible to eliminate all hazards from electrical test equipment. For this 
reason, every effort has been made to point out in this instruction manual the 
proper procedures and precautions to be followed by the user in operating this 
equipment and to mark the equipment itself with precautionary warnings where 
appropriate. It is not possible to foresee every hazard which may occur in the 
various applications of this equipment. It is therefore essential that the user, in 
addition to following the safety rules in this manual, also carefully consider all 
safety aspects of the test before proceeding. 

 Safety is the responsibility of the user. 

 Follow your company’s safety procedures. 

 Misuse of this high-voltage equipment can be extremely dangerous. 
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 The purpose of this equipment is limited to use as described in this 
manual. Do not use the equipment or its accessories with any device 
other than specifically described. 

 Never connect the test set to energized equipment. 

 Do not use the test set in an explosive atmosphere. 

 Corrective maintenance must only be performed by qualified personnel 
who are familiar with the construction and operation of the test set and 
the hazards involved. 

 Refer to IEEE 510 - 1983, IEEE Recommended Practices for Safety in High-
Voltage and High-Power Testing, for additional information. 

If the test equipment is operated properly and all grounds correctly made, test 
personnel need not wear rubber gloves. As a routine safety procedure, however, 
some users require that rubber gloves be worn, not only when making 
connections to the high-voltage terminals, but also when manipulating the 
controls. Megger considers this an excellent safety practice. 

Users of equipment should note that high-voltage discharges and other sources 
of strong electric or magnetic field may interfere with the proper functioning of 
heart pacemakers. Persons with heart pacemakers should obtain expert advice on 
the possible risks before operating this equipment or being close to the 
equipment during operation. 
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3 
Specifications 

Electrical 

Input Power 

 Cat. No. 
TTR310: 

 120 V ac ±10%, single phase, 50 ±2 Hz or 60 ±2 Hz, 
100 VA 

 IEC 1010-1 installation category II 

 Cat. No. 
TTR310-47: 

 230 V ac ±10%, single phase, 50 ±2 Hz or 60 ±2 Hz, 
100 VA 

 IEC 1010-1 installation category II 

Pollution Degree 

TTR310 is designed for Pollution Degree II 

Protective Devices 

Fuses (2)*: 

 Cat. No. 
TTR310: 

 Type T, 250 V, 1A (IEC 127 designation) 

 Cat. No. 
TTR310-47: 

 Type T, 250 V, 0.5 A (IEC 127 designation) 

 High voltage and low voltage measurement circuit shorting relays 

 Heavy duty varistors, transient voltage suppressors, and gas surge voltage 
protectors 

 * Two spare fuses are included with each TTR310 as spare parts 
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Output Test Voltage and Current 

 3 test voltages:  80 V rms, 40 V rms, 8 V rms. 

 Current:  up to 500 mA 

Test Frequency 

Same as line frequency. 

Loading of Test Transformer 

Less than 0.2 VA 

Measuring Ranges 

 Turn ratio:  80 V ac: 0.8 to 45,000, 5 digit resolution 
40 V ac: 0.8 to 25,000, 5 digit resolution 
8V ac: 0.8 to 8,000, 5 digit resolution 

 Excitation 
Current: 

 0 to 500 mA, 3 digit resolution 

 Phase Angle 
Deviation: 

 ± 90 degrees, 1 decimal point for the minutes display, 2 
decimal point for the degree display, 2 decimal points 
for the centiradian display 

Accuracy 

Turn ratio: 

 80 V ac:  ±0.1% (0.8 to 2000) 
±0.15% (2001 to 4000) 
±0.25% (4001 to 10000) 
±0.3% (10001 to 45000) 

 40 V ac:  ±0.1% (0.8 to 2000) 
±0.15% (2001 to 4000) 
±0.3% (4001 to 10000) 
±0.35% (10001 to 25000) 
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 8 V ac:  ±0.1% (0.8 to 2000) 
±0.25% (2001 to 4000) 
±0.35% (4001 to 8000) 

 Excitation 
Current (rms): 

 ±(2% of reading + 1 digit) 

 Phase Angle 
Deviation: 

 ±3 minutes 

Measurement Method 

In accordance with ANSI/IEEE C57.12.90 

Transformer Winding Phase Relationship 

ANSI C57.12.70-1990 

CEI/IEC 76-1:1993 and Publication 616:1978 

AS-2374, Part 4-1997 (Australian Standard) 

Measuring Time 

10 to 20 seconds depending on mode of operation and type of transformer 

Display 

LCD module, 256 x 128 dots. This translates to 42 characters by 16 lines.  

Memory Storage 

Up to 200 test results 

Up to 9 custom transformer settings 
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Interface 

RS232C 

Environmental Conditions 

 Operating temperature 
range: 

 23° to 122°F (-5 to 50 °C) 

 Storage temperature range:  -58° to 140°F  (-50 to 60 °C) 

 Relative humidity:  0 to 90% noncondensing (operating) 
0 to 95% noncondensing (storage) 

Physical Data 

 Dimensions:  17.5 x 10.5 x 6.9 in. (44.5 x 26.5 x 17.5 cm) (L 
x W x H) 

 Weight (test set):  16.5 lb. (7.5 kg) 

 Case:  Light gray color ABS case with lid and 
carrying strap 

Accessories Supplied 

Item (Qty) Cat. No. 

Canvas carrying bag for test leads 30915-211 

Power supply cord, 8 ft (2.5 m) 17032-4 

Ground lead, 15 ft (4.6 m) 4702-7 

Hand-held switch assembly for remote operation 30915-220 

RS232 serial cable for connecting to a PC 35248 

Ethernet cable for connecting to a PC 36798 

Bushing clips (6) MC7144 

Transformer Vector Voltage Diagram set 
(for ANSI, IEC, and AS Standards) 

35314 
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Item (Qty) Cat. No. 

PowerDB LITE DB0001 

Instruction Manual AVTMTTR310 

Optional Accessories 

Item (Qty) Cat. No. 

3-ø shielded test lead set, X/H windings, 30 ft   37093 

3-ø shielded test lead set, X/H windings, 50 ft   37094 

1-ø shielded test lead set, X/H windings, 30 ft   37095 

3-ø shielded test lead, H winding, 30 ft   30915-532 

3-ø shielded test lead, X winding, 30 ft   30915-534 

3-ø shielded test lead, H winding, 50 ft   30915-533 

3-ø shielded test lead, X winding, 50 ft   30915-535 

1-ø shielded test lead, H winding, 30 ft   30915-536 

1-ø shielded test lead, X winding, 30 ft   30915-537 

3-ø Adapter set to allow use of Megger 550503 lead sets    37087 

PowerDB (full version), 1st machine license, soft key DB1001 

PowerDB (full version), 1st machine license, USB dongle DB1001S 

Calibration device (for TTR verification) 550555 

Inverter with 3 ft (0.91 m) cigarette adapter cord  

    12 V dc to 120 V ac, 60 Hz  35271-1 

    12 V dc to 230 V ac, 60 Hz 35271-2 

    12 V dc to 120 V ac, 50 Hz 35271-3 

    12 V dc to 230 V ac, 50 Hz 35271-4 

Serial portable thermal paper printer (4” strip paper) 35755-3 

Transit case for instrument, leads and accessories 37009 
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Optional Upgrade kits 

Item (Qty) Cat. No. 

TTR330 Upgrade kit 37089-1 

TTR320 Icon Based view 37089-2 

TR310 Alphanumeric view 37089-3 

TTR300 “Black box” remote control 37089-4 
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4 
Description 

Principle of Operation 

The TTR310 test set provides accurate measurements of transformer input and 
output voltages and the, calculates a transformer turn ratio. The TTR310 also 
measures phase shift between primary and secondary windings of a transformer 
and transformer excitation current. 

A block diagram of the TTR310 test set is shown in Figure 4-1. The excitation 
voltage transformer converts the main voltage into the test excitation voltage of a 
transformer. The excitation voltage transformer outputs three test voltages: 80 V, 
40 V, and 8 V. The transformer under test excitation current is measured by the 
excitation current measurement circuitry. The test excitation voltage is applied to 
a transformer under test through the H winding lead select circuitry. This 
circuitry automatically excites the transformer windings depending on winding 
connections. The same excitation voltage is applied to the reference conditioning 
circuitry. 

The transformer under test output voltage is connected to the X winding lead 
select circuitry. This circuitry automatically connects the transformer winding 
being tested to the range conditioning circuitry.  
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Figure 4-1. Three-Phase TTR310 Test Set Block Diagram 

The range and reference conditioning circuitries isolate a transformer under test 
from the TTR310 measurement circuitry and provide conditioning of the input 
and output measurement signals. The programmable gain amplifier is used for 
additional conditioning of the transformer output signals.  

Both the reference A/D converter and the range A/D converter are used to 
convert the analog measurement signals to their digital replica. The converted 
output digital signals are applied to the microprocessor.  

The microprocessor orchestrates all steps of the TTR310 test set operation. It 
provides proper sequence of operation, gathers and calculates the test results, 
provides interfacing with the display, RS232/printer port, and the control 
circuitry. The control circuitry interfaces with virtually all function blocks 
described, providing proper control sequence of the TTR310 test set operation.  
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TTR310 Operational Flow Chart 

This flow chart illustrates the sequence of operation in a graphical manner. The 
Startup screen is the first screen that appears when the TTR310 is powered up. 
This is where the self-test will be performed and the embedded software version 
is indicated along with the present date and time. The Startup Screen always goes 
to the Main Menu. This is where the user interface commences.  

NOTE: See also page 65 for description of operation and 
menu/test screen. 

 

NOTE: Use the KEY on Figure 4.2 to identify the operation 
or function of the flow chart objects. 
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Figure 4-2. Quick Test flow chart 
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Figure 4-3. Full Test Setup with Recall Custom Settings 
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Main MenuStartup Screen

 System
Setup

 Language

English

Francaise

DeutschEspanol

ItalianaPortuguesa

Set Date
Time

StandardLanguage Main
Menu

Phase
Display

Test
Voltage

Quick Test 
Setup

Full Test 
Setup

Recall custom
 Settings

System
Setup Menu

Saved Data
Menu

Print
Header

ANSI
IEC
AS

⇑

⇓ Auto
80V
40V
8V

⇑

⇓

Degree
Centiradian

None

⇑

⇓

 

Figure 4-4. System Setup Menu 
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Figure 4-5. Saved Data Menu with Print Header 
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Controls, Indicators, and Connectors  

CONTRAST This knob adjusts the viewing resolution of the screen. 

TEST VOLTAGE 
ON 

Red indicator lamp indicates when lit that test voltage is being 
supplied to a transformer. 

EMERGENCY 
TEST OFF 

This red push button interrupts testing. When pressed, the 
switch is locked in off position. To reset the switch, twist the 
button in the direction indicated by the arrows. 

DISPLAY 
SCREEN 

LCD shows menus and test information. 

KEYPAD 16-button keypad for entering menu selections and navigating 
through the various screens. In addition to numbered keys 
1 through 9, plus 0, there is a CLR (clear) button, ↑R (raise or 
right) button, ↓L (lower or left) button, an ENT (enter) button, 
a decimal point button, and an * (asterisk) button. An audible 
tone confirms that you have successfully pressed a button.  

 

Figure 4-6. Three-Phase TTR310 Control Panel 

GROUND Wing-nut terminal allows connection of test set to earth ground. 

CABLE H Plug receptacle for connecting test leads to the high-voltage (H) 
winding of a transformer 

CABLE X Plug receptacle for connecting test leads to the low-voltage (X) 
winding of a transformer. 

Contrast 

X 

Test V ON

Remote 
trigger 

Input 
Power 

Display 

Keypad 

RS232/printer 

H 

GND 
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AC POWER 
120 V 50/60 Hz 
100 VA MAX 

On/off power switch and input power receptacle provides 
power to the test set. 

FUSE IEC 127 T 1 
A/250 V 

Fuse receptacle and rating. 

RS232/PRINTER Plug receptacle for connecting a printer or connecting to a PC. 
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5 
Setup and Connections 

General Instructions 

When testing high-voltage transformers, caution must be used at all times and all 
safety precautions followed. Read and understand all safety information 
contained in 
Section 2, Safety. 

WARNING 
Ensure that the transformer to be tested is completely de-
energized. Check every winding. Ensure that all terminals 
of the transformer are disconnected from line or load at the 
transformer. Connections to ground may be left in place. 

The following setup and connection instructions pertaining to ratio, polarity, and 
phase relation assume that the transformer under test, connections, and terminal 
markings comply with the requirements of ANSI C57.12.70-1990 American 
National Standards Terminal Markings and Connections for Distribution and Power 
Transformers. The H test leads of the test set are the exciting (high voltage) leads 
(8 V, 40 V, or 80 V).  

Single-Phase, Two-Winding Transformers 
WARNING 
Never interchange connections between the high- and low-
voltage transformer terminals. Failure to observe proper 
connections will result in a safety hazard and may result in 
damage to the test set or transformer. 

Perform the following setup procedure for single-phase, two-winding 
transformers: 

Connect the wing-nut ground terminal of the test set to a low-impedance earth ground using the 15-ft 
(4.6 m) ground lead supplied. 
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Connect the H and X test cables to the respective H and X receptacles of the test set. Make sure that the 
connectors are screwed tight to the receptacles. 

Connect the heavy-duty clips marked H1 and H2 of the test lead to the corresponding (high-voltage 
winding) terminals of the transformer under test.  

Connect the heavy-duty clips marked X1 and X2 of the test lead to the corresponding (low-voltage 
winding) terminals of the transformer under test. 
Figures 5-1 and 5-2 show test setups for single-phase transformers. Figures 5-3 and 5-4 show test setups 
for regulators. 

NOTE: When using a three-phase cable set, connect heavy-
duty clips marked H1, H2 and X1, X2 to the corresponding 
terminals of the transformer under test. The unused clips 
should be kept clear of ground and personnel. 

 

Figure 5-1. Setup for Testing Single-Phase Transformer 

 

Figure 5-2. Setup for Testing Single-Phase Autotransformer 



 
SETUP AND CONNECTIONS 

 

 
AVTMTTR310 Rev B Sept 2008 23

To test windings other than H1 – H2 and X1 – X2, ensure that the heavy-duty 
clip marked H1 is connected to the lower numbered terminal and H2 to the 
higher numbered terminal of the high-voltage winding. Similarly, X1 and X2 
should be connected to the low-voltage winding. Test lead markings for the 
ANSI, CEI/IEC, and Australian standards are as shown in Table 5-1. 

 

Table 5-1. Test Lead Markings for Single-Phase Transformers 

Test Lead Marking Transformer Heavy-Duty Clip Test Lead 

ANSI CEI/IEC Australian Terminal Voltage Boot Color Color Band

H1 1 U A2 High Red Red 

H2 1 V A1 High Red Yellow 

X1 2 U a2 Low Black Red 

X2 2 V a1 Low Black Yellow 

 

 

Figure 5-3. Setup for Testing Single-Phase, Type A (Straight Design) Step Voltage Regulator 
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Figure 5-4. Setup for Testing Single-Phase, Type B (Inverted Design) Step Voltage Regulator 

Three-Phase, Two-Winding Transformers 

Perform the following setup procedure for three-phase, two-winding 
transformers: 

1. Connect the wing-nut ground terminal of the test set to a low-impedance 
earth ground using the 15 ft (4.6 m) ground lead supplied. 

Connect the three-phase test cables to the respective H and X receptacles of the test set. Make sure that 
the connectors are screwed tight to the receptacles. 

Connect the heavy-duty clips marked H0, H1, H2, and H3 of the test lead to the corresponding (high-
voltage winding) terminals of the transformer under test. 

Connect the heavy-duty clips marked X0, X1, X2 , and X3 of the test lead to the corresponding (low-
voltage winding) terminals of the transformer under test. 
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WARNING 
Never interchange connections between the high- and low-
voltage transformer terminals. Failure to observe proper 
connections will result in a safety hazard and may result in 
damage to the test set or transformer. 

The unused H0 and X0 terminals should be kept clear of ground and personnel 
because they could become energized during the test. Refer to Table 5-2 for test 
lead markings. 

With delta connected windings, H0 or X0 is not used. With wye connected 
windings, a neutral connection is normally available. 

Table 5-2. Test Lead Markings for Three-Phase Transformers 

Test Lead Marking Transformer Heavy-Duty Clip Test Lead  

ANSI CEI/IEC Australian Terminal Voltage Boot Color Color Band 

H0 1N N Neutral Red White 

H1 1U A2/A4 High Red Red 

H2 1V B2/B4 High Red Yellow 

H3 1W C2/C4 High Red Blue 

X0 2N N Neutral Black White 

X1 2U a1/a2/a4 Low Black Red 

X2 2V b1/b2/b4 Low Black Yellow 

X3 2W c1/c2/c4 Low Black Blue 

 

Note: According to Australian standard, wye and delta 
transformer winding connections have a numerical suffix of 1 
and 2. The zigzag transformers have a numerical suffix of 4. 
See Table 5-6. 
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Three-Phase, Three-Winding Transformers 

This type of transformers has primary, secondary and tertiary windings. Primary 
and secondary windings are tested as a regular three-phase, two-winding 
transformer. To test tertiary winding, perform the following setup procedure:  

2. Connect the wing-nut ground terminal of the test set to a low-impedance 
earth ground using the 15 ft (4.6 m) ground lead supplied. 

Connect the three-phase test cables to the respective H and X receptacles of the test set. Make sure that 
the connectors are screwed tight to the receptacles. 

Connect the heavy-duty clips marked H0, H1, H2, and H3 of the test lead to the corresponding (high-
voltage winding) terminals of the transformer under test. 

Connect the heavy-duty clips marked X0, X1, X2 , and X3 of the test lead to the corresponding tertiary 
(low-voltage winding) terminals (Y0, Y1, Y2, and Y3) of the transformer under test. 

WARNING 
Never interchange connections between the high- and low-
voltage transformer terminals. Failure to observe proper 
connections will result in a safety hazard and may result in 
damage to the test set or transformer. 

The unused H0 and X0 terminals should be kept clear of ground and personnel 
because they could become energized during the test. Refer to Table 5-2 for test 
lead markings. 

With delta connected windings, H0 or X0 is not used. With wye connected 
windings, a neutral connection is normally available. 
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Current Transformers (CTs)  

Connections to CTs are made backwards compared to power or potential 
transformers. The H terminals on the test set must be connected to the X 
terminals on the CT; and the X terminals on the test set must be connected to 
the H terminals on the CT. 

NOTE: Dots on the housing of the transformer are 
commonly used to identify terminals of the same polarity. 

WARNING 
Failure to observe proper connections will result in a safety 
hazard and may result in damage to the test set or CT. 
Failure to observe voltage rating of low-current X winding 
may result in damage to the CT.  

 

CAUTION 
Never use AUTO mode of operation when testing the current 
transformers with the rated voltage below 80 V ac.  

Most of the CTs are tested at 8 V ac excitation voltage. 

NOTE: Most of the current transformers are tested at 8 V ac 
excitation voltage. Some current transformers with turn ratio 
of 100:5 and less get saturated at 8V ac. They require lower 
excitation voltage for testing and therefore can not be tested 
with the Cat.No TTR310. Us the TTR100 or TTR25. 

Unmounted CTs 

3. Connect the wing-nut ground terminal of the test set to a low-impedance 
earth ground using the 15-ft (4.6 m) ground cable supplied. 

Use the TTR310  H and X test leads and connect as follows and as shown in Figure 5-5. 

Connect the heavy-duty clips marked H1 and H2 of the test lead to the respective X1 and X2 terminals 
of the CT. 

Connect the heavy-duty clips marked X1 and X2 of the test lead to the respective H1 and H2 terminals 
of the CT. Ensure correct polarity.  
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Figure 5-5. Setup for Testing Unmounted Current Transformer 

Figure 5-6 shows the setup for testing the taps on a multiple-tap CT. 

 

Figure 5-6. Setup for Testing Taps on Multiple Tap CT 
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Bushing Current Transformer (BCT) Mounted on Single-Phase, 
Two-Winding Transformer 

A turn-ratio test can be performed on a BCT after it has been mounted on a 
circuit breaker or power transformer entrance bushing. The test can be 
performed without removal of the BCT from the equipment. Proceed as follows 
and as shown in Figure 5-7. 

4. Connect the wing-nut ground terminal of the test set to a low-impedance 
earth ground using the 15-ft (4.6 m) ground cable supplied. 

Use the TTR310 two or four conductor H and X test leads. 

Short-circuit the winding on the opposite voltage side of the power transformer core, using jumper 
leads. 

Connect the heavy-duty clips marked H1 and H2 of the test leads to the respective X1 and X2 terminals 
of the BCT. 

Connect the heavy-duty clip marked X1 to the power transformer terminal on which the BCT is 
mounted and the X2 heavy-duty clip to the terminal on the opposite side of the power transformer 
winding (H2 side of BCT). Check to make sure that the BCT is mounted with proper polarity with 
respect to power transformer entrance bushing and that connection polarities are correct. 

 

Figure 5-7. Setup for Testing BCT Mounted on Single-Phase Two-Winding Transformer 
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BCTs Mounted on Three-Phase Transformers 
A turn-ratio test can be performed on all three BCTs using a single setup. Figure 
5-8 shows how to make the proper connections when the BCTs are mounted on 
a typical delta winding and Figure 5-9 when mounted on a typical wye winding. 

5. Use four conductor H and X test leads. 

Short-circuit all windings on the opposite voltage side of the power transformer core using jumper leads. 

Check to make sure that all BCTs are mounted with proper polarity with respect to the power 
transformer entrance bushing. Ensure that all connection polarities are correct. 
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Figure 5-8. Setup for Testing BCT Mounted on Delta Winding on a Three-Phase Power Transformer 
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Figure 5-9. Setup for Testing BCT Mounted on Wye Winding of a Three-Phase Transformer 
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T-Type Transformers 

T-type transformers represent the special type of thee-phase transformers. This 
transformer may be tested as a single phase transformer. In this case, the jumpers 
indicated in Table 5-3 should be applied to the appropriate terminals of the T-
type transformers. The TTR310 measured turn ratio should be compared to the 
calculated turn ratio indicated in Table 5-3. 

 
Table 5-3. T-type Transformer Winding Phase Relationship 

 Winding Connection   Winding Tested   
IEC 

Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

External 
jumpers 

Phase 
tested 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Calculated 
Turn Ratio 

 
 

Remarks 
 
 
 
 

T-T 
0 
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30  
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V

H
X
•

3
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H2 -H3 
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B 

 
 

H1 – H3 

 

 

 
H2 – H3 

 
 

X1 – X3 

 

 

 
X2 – X1 

 

2
3

V
V

X
H •  

 

 

 

NOTE: When testing T-type transformer, the diagram 
number 1 should be entered at the Quick Test Setup screen 
(See Figure 6-3) or at the Full Test Setup 1 screen 
(See Figure 6-6). 
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Connections and Vector Voltage Diagrams 

When testing three-phase transformers, it is necessary to understand the phase 
relationships, vector diagrams, and winding connection diagrams for these 
transformers. A detailed description of phase relationships, vector diagrams, and 
terminal markings is contained in specification ANSI C57.12.70 –1990 American 
National Standard Terminal Markings and Connections for Distribution and Power 
Transformers. 

Refer to specification CEI/IEC 76-1:1993 and Publication 616:1978 for 
International Standard terminal and tapping markings for power transformers. 
Refer to specification AS-2374, Part 4-1997 for Australian standard tappings and 
connections for power transformers. 

Table 5-4 shows winding diagrams for standard transformers and nonstandard 
transformers for power and distribution transformers marked in accordance with 
the ANSI standard. Table 5-5 shows winding diagrams for power transformers 
marked in accordance with the CEI/IEC standard, and Table 5-6 shows winding 
diagrams for power transformers marked in accordance with the Australian 
standard. 

To make a measurement on a three-phase power transformer, match the vector 
diagram from the transformer nameplate to the corresponding winding 
connection diagram from Table 5-4 through 5-6, then enter the corresponding 
diagram number (column 1 of table) in the appropriate setup menu of the 
instrument. 

The tables show the windings tested for each of the three-phases. The tables also 
show the relationship between the measured turn ratio and the actual line-to-line 
voltage ratio. For the ANSI specification, the rated voltage on the high-voltage 
winding is represented by VH; VX represents rated voltage on the low-voltage 
winding. 

The TTR310 is also capable of measuring the turn ratio on three-phase 
transformers with an inaccessible neutral point. In this case, the TTR310 
automatically shorts an appropriate transformer winding, listed in the winding 
shorted column of the table. An inaccessible neutral point on the high-voltage or 
low-voltage transformer winding is designated by the symbol *. 

For many utilities, different manufacturer nameplate diagrams make it impossible 
to always find a corresponding diagram on Tables 5-4 to 5-6. To help determine 
the correct connection and to test any transformer, the following explanation will 
help self-check your work. 
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Figure 5-10 (a) shows the relationship in a typical delta-wye connected 
transformer with accessible neutral connection point. The delta winding is the 
high-voltage winding and the terminals are marked H1, H2, and H3. The wye 
winding is the low-voltage winding and the terminals are marked X0, X1, X2, and 
X3. Determine which windings (lines) are parallel to each other. In the diagram, 
winding 

H1 – H3 is parallel to X1 – X0 as illustrated by the two solid straight arrows. Only 
H1 – H3 will ratio against X1 – X0. Also H2 – H1 is parallel to X2 – X0, and H3 – 
H2 is parallel to 
X3 – X0. All ratio measurements are made between parallel windings. The phase 
polarity must also be observed and is designated by the order of terminal 
mention, i.e., H1 - H3 is of the same phase polarity as X1 – X0. 

Note that the phase displacement for Figure 5-10 (a) diagram is 30° and has an 
IEC vector group coding of Dyn1. Refer to the notes to Tables 5-4 through 5-6 
for an explanation of vector group coding. For phase displacement between 
windings the vector relating to the HV winding is taken as the vector of origin 
(dotted line on delta winding, H1 on wye winding). The vector relating to the 
low-voltage wye winding is taken as X1 (dotted line on a delta winding) and is 
expressed in counterclockwise rotation of low-voltage winding in 30° clock-hour 
figure increments. The low-voltage winding lag may be from 0 to 330° in steps of 
30°. 

The TTR310 test set is capable of measuring the turn ratio of three-phase 
transformers where the windings are rotated or are connected in various phase 
displacements from standard. Figure 5-10 (b) vector diagram is an example of a 
typical case where the phase is displaced 150° from that of Figure 5-10 (a) 
diagram. Vector group coding for this diagram is Dyn5. 

Figure 5-10 (c) is an example of a nameplate vector diagram drawn differently 
from that of Figure 5-5 (a). Although a corresponding figure cannot be found in 
Table 5-4, the transformer and its testing is identical to that for Figure 5-10 (a). 

Figure 5-10 (d) vector diagram is an example of a typical wye-delta connected 
transformer winding which has a phase displacement of 210°. H1 is the high-
voltage winding vector of origin and the dotted line on the delta winding is the 
low-voltage winding reference. Vector group coding for this diagram is YNd7. 
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(a) 

 
 
 
 
IEC VECTOR GROUP CODING 
Dyn1 
PHASE DISPLACEMENT  
30° LAG 

   

  
 
(b) 

 
 
 
 
 
IEC VECTOR GROUP CODING 
Dyn5 
PHASE DISPLACEMENT  
150° LAG 

   

 

 
 
(c) 

 
 
 
 
 
IEC VECTOR GROUP CODING 
Dyn1 
PHASE DISPLACEMENT 
30° LAG 

   
 

 

 
 
(d) 

 
 
 
 
IEC VECTOR GROUP CODING 
YNd7 
PHASE DISPLACEMENT  
210° LAG 

Figure 5-10. Winding Connections and Phase Relationship 
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Notes to Table 5-4 

Transformer terminal markings for distribution and power transformers marked 
in accordance with requirements of American National Standard Institute, Inc 
(ANSI) standard C57.12.70 – 1978. 

Definition of Symbol Designations 

H1, H2, H3 External terminals on HV transformer winding. 

X1, X2, X3 External terminals on LV transformer winding. 

H0  External neutral terminal on HV transformer winding. 

X0  External neutral terminal on LV transformer winding. 

*   Inaccessible neutral point on HV or LV transformer winding. 

VH  Nameplate voltage rating (line-to-line) of HV transformer 
winding. 

VX  Nameplate voltage rating (line-to-line) of LV transformer 
winding. 

A, B, C  Winding tested on HV side of transformer. 

a, b, c  Winding tested on LV side of transformer. 

IEC Vector Group Coding 

The letters indicate the three-phase winding connections; D, Y, and Z designate 
the HV side winding; d, y, and z designate the LV side winding. D and d 
represent a delta connection, Y and y represent a wye connection, and Z and z 
represent a zigzag connection. N and n indicate that the neutral point of a star or 
zigzag connected winding is accessible on the respective HV or LV side winding. 
The number indicates the phase displacement (lag) of the LV winding with 
respect to the HV winding in units of 30º.  

For example, 0 = 0º lag, 1 = 30º lag, 2 = 60º lag, 6 = 180º lag, 11 = 330º lag. 
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Additional Transformer Winding Identification 

External terminal markings for three-phase power transformers with more than 
two windings are as follows: 

Y1, Y2, Y3 Third winding (if any). 

Z1, Z2, Z3 Fourth winding (if any). 

If unable to find a corresponding diagram for a transformer with, for example, 
accessible neutral winding but can find the corresponding diagram for the same 
transformer with no neutral accessible winding, follow the test procedure for the 
transformer with no neutral accessible winding. In this case, specify the diagram 
number for the transformer with no neutral accessible winding and do not 
connect H0 or X0 lead to the neutral. Note that on the print out of the results, 
the vector designation and the corresponding diagram will not be EXACT, but 
will be close to the actual transformer configuration. 

As an example, if transformer winding connection is identical to Table 5-4 
Diagram 
No. 26 except the wye winding has an accessible neutral winding, perform test 
per Diagram 26. Do not connect H0 lead to the wye winding neutral terminal. 
The test results are identical and do not require any corrections. Note that on the 
print out of the results, the vector designation and the corresponding diagram 
will not be EXACT, but will be close to the actual transformer configuration. 
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Table 5-4. ANSI Transformer Winding Phase Relationship 

Copyright 1999© Megger 
  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 
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1 
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transformer 
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  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 
8 

 
 
 
 

YNyn6 

 

 
 

 

 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 

X0 - X1 
X0 - X2 
X0 - X3 

 
 
 

V
V

H

X
 

 
 

 
Neutral 

accessible 
both wye 
windings 

 
 
 
 
9 

 
 
 
 

YNd1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 

X1 - X2 
X2 - X3 
X3 - X1 

 
 
 

V

V
H

X • 3
 

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

10 

 
 
 
 

YNd7 

 

 
 

 

 
 

 
 

 
 

A 
B 
C 

 
 
 

 
 

⎯ 

 
 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 
 

X2 - X1 
X3 - X2 
X1 - X3 

 
 
 

V

V
H

X • 3
 

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

11 

 
 
 
 

Dy1 

 

 
 

 

 
 

 
 
 
 

A 
B 
C 

 
 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 
 
H1-(H3-H2) 
H2-(H1-H3) 
H3-(H2-H1) 

 
 
 
 

X1 - X2 
X2 - X3   
X3 - X1 

 

 
 
 

V
V

H
X

• 3  

 
 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

12 

 
 
 
 

Dyn5 

 

 
 

 

 
 

 
 

 
A 
B 
C 

 
 

 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X3 - X0 
X1 - X0 
X2 - X0 

 
 
 

V
V

H
X

• 3  

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

13 

 
 
 
 

Dy5 

 

 
 

 

 
 

 
 

 
A 
B 
C 

 
 

 
H3 - H2 
H1 – H3 
H2 – H1 

 
 

 
H1-( H3-H2)
H2-( H1-H3) 
H3-( H2-H1)

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X

• 3  

 
 

No 
accessible 
neutral on 

wye winding 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

14 

 
 
 
 

Dy7 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3-H2) 
H2-(H1-H3) 
H3-(H2-H1) 

 
 
 

X2 - X1 
X3 - X2 
X1 - X3 

 
 
 

V
V

H
X

• 3  

 
 

 
No 

accessible 
neutral on 

wye winding 

 
 
 
 

15 

 
 
 
 

Dyn11 

 

 
 

 

 
 

 
 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X0 - X3 
X0 - X1 
X0 - X2 

 
 
 

V
V

H
X

• 3  

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

16 

 
 
 
 

Dy11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3-H2) 
H2-(H1-H3) 
H3-(H2-H1) 

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X

• 3  

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

17 

 
 
 
 

Dz0 

 

 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X

 

 
 
 

No 
accessible 

neutral 

 
 
 
 

18 

 
 
 
 

Dz6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X

 

 
 
 

No 
accessible 

neutral 

 
 
 
 

19 

 
 
 
 

YNy0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H2 - H0 
H3 - H0 
H1 - H0 

 
 
 

H1-(H2-H0) 
H2-(H3-H0) 
H3-(H1-H0) 

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X

 

 
 

No 
accessible 
neutral on 

low-voltage 
winding 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
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  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

20 

 
 
 
 

Yyn0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X

 

 
 

No 
accessible 
neutral on 

high-voltage 
winding 

 
 
 
 

21 

 
 
 
 

Yy0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X

 

 
 

No 
accessible 

neutral both 
wye windings

 
 
 
 

22 

 
 
 
 

YNy6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H2 - H0 
H3 - H0 
H1 - H0 

 
 
 

H1-(H2-H0) 
H2-(H3-H0) 
H3-(H1-H0) 

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X

 

 
 

No 
accessible 
neutral on 

low-voltage 
winding 

 
 
 
 

23 

 
 
 
 

Yyn6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X

 

 
 

No 
accessible 
neutral on 

high-voltage 
winding 

 
 
 
 

24 

 
 
 
 

Yy6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X

 

 
 

No 
accessible 
neutral on 
both wye 
windings 

 
 
 
 

25 

 
 
 
 

Yzn1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X1 - X0 
X2 - X0 
X3 - X0 

 
 
 

V
V

H
X

• 3  

 
 

No 
accessible 
neutral on 

wye winding 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
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  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

26 

 
 
 
 

Yz1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X1 - X2 
X2 - X3 
X3 - X1 

 
 
 

V
V

H
X
•

3
2

 

 
 
 

No 
accessible 

neutral 

 
 
 
 

27 

 
 
 
 

Yzn5 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X3 - X0 
X1 - X0 
X2 - X0 

 
 
 

V
V

H
X

• 3  

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

28 

 
 
 
 

Yz5 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X
•

3
2

 

 
 
 

No 
accessible 

neutral 

 
 
 
 

29 

 
 
 
 

Yzn7 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X0 - X1 
X0 - X2 
X0 - X3 

 
 
 

V
V

H
X

• 3  

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

30 

 
 
 
 

Yz7 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X2 - X1 
X3 - X2 
X1 - X3 

 
 
 

V
V

H
X
•

3
2

 

 
 
 

No 
accessible 

neutral 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
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  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

31 

 
 
 
 

Yzn11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X0 - X3 
X0 - X1 
X0 - X2 

 
 
 

V
V

H
X

• 3  

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

32 

 
 
 
 

Yz11 

 

 
 

 

 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X
•

3
2

 

 
 
 

No 
accessible 

neutral 
 

 
 
 
 

33 

 
 
 
 

ZNy5 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H

X • 3
 

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

34 

 
 
 
 

Zy5 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X
•

3
2

 

 
 
 

No 
accessible 

neutral 

 
 
 
 

35 

 
 
 
 

ZNy11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H

X • 3
 

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

36 

 
 
 
 

Zy11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

V
V

H
X
•

3
2

 

 
 
 

No 
accessible 

neutral 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

37 

 
 
 
 

Yd1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X1 - X2 
X2 - X3 
X3 - X1 

 
 
 

V
V

H

X
•

3
2

 

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

38 

 
 
 
 

YNd5 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H

X • 3
 

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

39 

 
 
 
 

Yd5 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X3 - X1 
X1 - X2 
X2 - X3 

 
 
 

V
V

H
X
•

3
2

 

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

40 

 
 
 
 

Yd7 

 

 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X2 - X1 
X3 - X2 
X1 - X3 

 
 
 

V
V

H
X
•

3
2

 

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 
 

41 

 
 
 
 

YNd11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H0 
H2 - H0 
H3 - H0 

 
 
 

X1 - X3 
X2 – X1 
X3 – X2 

 
 
 

V
V

H

X • 3
 

 
 
 

Neutral 
accessible 

on wye 
winding 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
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  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

42 

 
 
 
 

Yd11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X1 - X3 
X2 - X1 
X3 - X2 

 
 
 

2
3

V
V

X

H •  

 
 

No 
accessible 
neutral on 

wye winding 

 
 
 

43 VREG 

 

 
_ 

1φ 
 _ S-SL L-SL 

V
V

H
X

 _ 

 
 
 
 

44 

 
 
 
 
Dyn3 

 

 
 

 
  
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H3 – H1 
H1 – H2 
H2 – H3 

 
 
 

X2 – X0 
X3 – X0 
X1 – X0 

 
 
 

3V
V

X

H

•
 

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

45 

 
 
 
 

Dy3 

 

 
 

 

X2

X 1 

X 3  
 

 
 
 

A 
B 
C 

 
 
 

H3 - H2 
H1 - H3 
H2 - H1 

 
 
 

H1-(H3+H2) 
H2-(H1+H3) 
H3-(H2+H1)

 
 
 

X3 - X2 
X1 - X3 
X2 – X1 

 
 
 

3
2

V
V

X

H •  

 
 

 
No 

accessible 
neutral on 

wye winding 

 
 
 
 

46 

 
 
 
 

Dyn9 

 

 
 

 
 

X2 

X1

X3

X0

 

 
 

 
A 
B 
C 

 
 

 
 
⎯ 

 
 
 

H1 - H3  
H2 - H1 
H3 - H2  

 
 
 

X2 - X0 
X3 - X0 
X1 - X0  

 
 
 

3V
V

X

H

•
 

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

47 

 
 
 
 

Dy9 

 

 
 

 
 

X2 

X1

X3

*

 

 
 

 
A 
B 
C 

 
 

 
H3 - H2 
H1 – H3 
H2 – H1 

 
 

 
H1-( H3+H2)
H2-( H1+H3) 
H3-( H2+H1)

 
 
 

X2 - X3 
X3 - X1 
X1 - X2 

 

 
 
 

3
2

V
V

X

H •  

 
 

No 
accessible 
neutral on 

wye winding 

   S 

L 

SL 
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Table 5-4. ANSI Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage 
Winding (H) 

 
Low-Voltage 
Winding (X) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High-
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio 

 
 

Remarks 
 
 
 
 

48 

 
 
 
 

YNzn1 

 
 

 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X1 - X0 
X2 - X0 
X3 - X0 

 
 
 

V
V

H
X

• 3  

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

49 

 
 
 
 

YNzn7 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X0 - X1 
X0 - X2 
X0 - X3 

 
 
 

V
V

H
X

• 3  

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

50 

 
 
 
 

YNzn11 

 
 

 

 

 
 

 
 
 

A 
B 
C 

 
 
 
 
⎯ 

 
 
 

H1 - H3 
H2 - H1 
H3 - H2 

 
 
 

X0 - X3 
X0 - X1 
X0 - X2 

 
 
 

V
V

H
X

• 3  

 
 

Neutral 
accessible 

on wye 
winding 

 



M 
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Notes to Table 5-5 

Transformer terminal markings for power transformers marked in accordance 
with requirements of International Standard CEI/IEC 76-1:1993. 

Definition of Symbol Designations 

1U, 1V, 1W External terminals on HV transformer winding  
(alternate notation U, V, W). 

2U, 2V, 2W External terminals on LV transformer winding 
(alternate notation u, v, w). 

1N External neutral terminal on HV transformer winding 
(alternate notation N). 

2N External neutral terminal on LV transformer winding 
(alternate notation n). 

* Inaccessible neutral point on HV or LV transformer winding. 

U1 Nameplate voltage rating (line-to-line) of HV transformer 
winding. 

U2 Nameplate voltage rating (line-to-line) of LV transformer 
winding. 

U, V, W Phase tested. 

IEC Vector Group Coding 

The letters indicate the three-phase winding connections; D, Y, and Z designate 
the HV side winding; d, y, and z designate the LV side winding. D and d 
represent a delta connection, Y and y represent a wye connection, and Z and z 
represent a zigzag connection. N and n indicate that the neutral point of a star or 
zigzag connected winding is accessible on the respective HV or LV side winding. 
The number indicates the phase displacement (lag) of the LV winding with 
respect to the HV winding in units of 30º.  

For example, 0 = 0º lag, 1 = 30º lag, 2 = 60º lag, 6 = 180º lag, 11 = 330º lag. 
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Additional Transformer Winding Identification 

External terminal markings for three-phase power transformers with more than 
two windings are as follows: 

3U, 3V, 3W  Third winding (if any). 

4U, 4V, 4W  Fourth winding (if any). 

If unable to find a corresponding diagram for a transformer with, for example, 
accessible neutral winding but can find the corresponding diagram for the same 
transformer with no neutral accessible winding, follow the test procedure for the 
transformer with no neutral accessible winding. In this case, specify the diagram 
number for the transformer with no neutral accessible winding and do not 
connect 1N or 2N lead to the neutral.  

As an example, if transformer winding connection is identical to Table 5-5 
Diagram 
No. 43 except the wye winding has an accessible neutral winding, perform test 
per Diagram 43. Do not connect 1N lead to the wye winding neutral terminal. 
The test results are identical and do not require any corrections. 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 

Copyright 1999© Megger 
  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
1 

 
1φ 

1ph0 
 

 
 

 

 
 

 

 
 

1φ 

 
 
⎯ 

 
 

1.1-1.2 

 
 

2.1-2.2 

 
U1
U2

 

 
Single-phase 
transformer 

 
 
2 

 
1φ 

1ph6 
 

 
 

 

 
 

 

 
 

1φ 

 
 
⎯ 

 
 

1.1-1.2 

 
 

2.2-2.1 

 
U1
U2

 

 
Single-phase 
transformer 

 
 
 
3 

 
 
 

Dd0 

 

 
 

 

 

 
 

U 
V 
W 

 
 
⎯ 
⎯ 
⎯ 

 
 

1U-1V 
1V-1W 
1W-1U 

 
 

2U-2V 
2V-2W 
2W-2U 

 
 

U1
U2

 

 
 
 
⎯ 

 
 
 
4 

 
 
 

Dd2 

 

 
 

 

 

 
 

U 
V 
W 

 
 
⎯ 
⎯ 
⎯ 

 
 

1U-1V 
1V-1W 
1W-1U 

 
 

2W-2V 
2U-2W 
2V-2U 

 
 

U1
U2

 

 
 
 
⎯ 

 
 
 
5 

 
 
 

Dd4 

 

 
 

 

 

 
 

U 
V 
W 

 
 
⎯ 
⎯ 
⎯ 

 
 

1U-1V 
1V-1W 
1W-1U 

 
 

2W-2U 
2U-2V 
2V-2W 

 
 

U1
U2

 

 
 
 
⎯ 

 
 
 
6 

 
 
 

Dd6 

 

 
 

 

 

 
 

U 
V 
W 

 
 
⎯ 
⎯ 
⎯ 

 
 

1U-1V 
1V-1W 
1W-1U 

 
 

2V-2U 
2W-2V 
2U-2W 

 
 

U1
U2

 

 
 
 
⎯ 

 
 
 
7 

 
 
 

Dd8 

 

 
 

 

 

 
 

U 
V 
W 

 
 
⎯ 
⎯ 
⎯ 

 
 

1U-1V 
1V-1W 
1W-1U 

 
 

2V-2W 
2W-2U 
2U-2V 

 
 

U1
U2

 

 
 
 
⎯ 

 
 
 
8 

 
 
 

Dd10 

 

 
 

 

 

 
 

U 
V 
W 

 
 
⎯ 
⎯ 
⎯ 

 
 

1U-1V 
1V-1W 
1W-1U 

 
 

2U-2W 
2V-2U 
2W-2V 

 
 

U1
U2

 

 
 
 
⎯ 



 
SETUP AND CONNECTIONS 

 

 
AVTMTTR310 Rev B Sept 2008 51

Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 
9 

 
 
 
 

Dyn1 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1W 
1V-1U 
1W-1V 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1
U2
• 3  

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 

 
 

10 

 
 

 
 

Dy1 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-1W 
1V-1U 
1W-1V 

 
 
 

2U-* 
2V-* 
2W-* 

 
 
 

U1
U2
• 3  

 
 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

11 

 
 
 
 

Dyn5 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1V-1U 
1W-1V 
1U-1W 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1
U2
• 3  

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

12 

 
 
 
 

Dy5 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1V-1U 
1W-1V 
1U-1W 

 
 
 

2U-* 
2V-* 
2W-* 

 
 
 

U1
U2
• 3  

 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

13 

 
 
 
 

Dyn7 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1W-1U 
1U-1V 
1V-1W 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1
U2
• 3  

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

14 

 
 
 
 

Dy7 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1W-1U 
1U-1V 
1V-1W 

 
 
 

2U-* 
2V-* 
2W-* 

 
 
 

U1
U2
• 3  

 
 

No neutral 
accessible 

on wye 
winding 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 

 
 

15 

 
 
 
 

Dyn11 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1
U2
• 3  

 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

16 

 
 
 
 

Dy11 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-* 
2V-* 
2W-* 

 
 
 

U1
U2
• 3  

 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

17 

 
 
 
 

Dzn0 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

1.5U1
U2

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

18 

 
 
 
 

Dz0 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-2V 
2V-2W 
2W-2U 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

19 

 
 
 
 

Dzn2 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2N-2V 
2N-2W 
2N-2U 

 
 
 

1.5U1
U2

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

20 

 
 
 
 

Dz2 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2W-2V 
2U-2W 
2V-2U 

 
 
 

U1
U2

 

 
 
 

No neutral 
accessible 
on zigzag 
winding 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 

21 

 
 
 
 

Dzn4 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2W-2N 
2U-2N 
2V-2N 

 
 
 

1.5U1
U2

 

 
 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

22 

 
 
 
 

Dz4 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2W-2U 
2U-2V 
2V-2W 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

23 

 
 
 
 

Dzn6 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2N-2U 
2N-2V 
2N-2W 

 
 
 

1.5U1
U2

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

24 

 
 
 
 

Dz6 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2V-2U 
2W-2V 
2U-2W 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

25 

 
 
 
 

Dzn8 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2V-2N 
2W-2N 
2U-2N 

 
 
 

1.5U1
U2

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

26 

 
 
 
 

Dz8 

 

 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2V-2W 
2W-2U 
2U-2V 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 
on zigzag 
winding 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 

27 

 
 
 
 

Dzn10 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2N-2W 
2N-2U 
2N-2V 

 
 
 

1.5U1
U2

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

28 

 
 
 
 

Dz10 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-2W 
2V-2U 
2W-2V 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

29 

 
 
 
 

YNyn0 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1
U2

 

 
 

Neutral 
accessible 
on HV & LV 

winding 

 
 
 
 

30 

 
 
 
 

YNy0 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1N 
1W-1N 
1U-1N 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2U-* 
2V-* 
2W-* 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 

on LV 
winding 

 
 
 
 

31 

 
 
 
 

Yyn0 

 

 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-2V 
2V-2W 
2W-2U 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 

on HV 
winding 

 
 
 
 

32 

 
 
 
 

Yy0 

 

 
 

  
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-2V 
2V-2W 
2W-2U 

 
 
 

U1
U2

 

 
 

No neutral 
accessible 
on HV & LV 

windings 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 

33 

 
 
 
 

YNyn6 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2N-2U 
2N-2V 
2N-2W 

 
 
 

U1
U2

 

 
 

Neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

34 

 
 
 
 

YNy6 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1N 
1W-1N 
1U-1N 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

*-2U 
*-2V 
*-2W 

 
 
 

U1
U2

 

 
 
 

No neutral 
accessible 

on LV 
winding 

 
 
 
 

35 

 
 
 
 

Yyn6 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2V-2U 
2W-2V 
2U-2W 

 
 
 

U1
U2

 

 
 
 

No neutral 
accessible 

on HV 
winding 

 
 
 
 

36 

 
 
 
 

Yy6 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2V-2U 
2W-2V 
2U-2W 

 
 
 

U1
U2

 

 
 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

37 

 
 
 
 

Yzn1 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1W 
1V-1U 
1W-1V 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1 3
U2
•  

 
 

With or 
without 

accessible 
neutral on 

wye winding 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 

38 

 
 
 
 

Yz1 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2U-2V 
2V-2W 
2W-2U 

 
 
 

U1
U2

•
3
2

 

 
 

No neutral 
accessible 
on HV & LV 

winding 

 
 
 
 

39 

 
 
 
 

Yzn5 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2N-2U 
2N-2V 
2N-2W 

 
 
 

U1 3
U2
•  

 
 

With or 
without 

accessible 
neutral on 

wye winding 

 
 
 
 

40 

 
 
 
 

Yz5 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2W-2U 
2U-2V 
2V-2W 

 
 
 

U1
U2

•
3
2

 

 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

41 

 
 
 
 

Yzn7 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2V-2N 
2W-2N 
2U-2N 

 
 
 

U1 3
U2
•  

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

42 

 
 
 
 

Yz7 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2V-2U 
2W-2V 
2U-2W 

 
 
 

U1
U2

•
3
2

 

 
 

No neutral 
accessible 
on HV & LV 

windings 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 

43 

 
 
 
 

Yzn11 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1V 
1V-1W 
1W-1U 

 
 
 

2U-2N 
2V-2N 
2W-2N 

 
 
 

U1 3
U2
•  

 
 

With or 
without 

accessible 
neutral on 

wye winding 

 
 
 
 

44 

 
 
 
 

Yz11 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2U-2W 
2V-2U 
2W-2V 

 
 
 

U1
U2

•
3
2

 

 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

45 

 
 
 
 

YNd1 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2U-2V 
2V-2W 
2W-2U 

 
 

 

32

1

•U

U  

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

46 

 
 
 
 

Yd1 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2U-2V 
2V-2W 
2W-2U 

 
 
 

U1
U2

•
3
2

 

 
 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

47 

 
 
 

 
YNd5 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

⎯ 
⎯ 
⎯ 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2W-2U 
2U-2V 
2V-2W 

 
 

 

32

1

•U

U  

 
 
 

Neutral 
accessible 

on wye 
winding 
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Table 5-5. CEI/IEC 76-1:1993 Transformer Winding Phase Relationship 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (U1) 

 
Low-Voltage  
Winding (U2) 

 
Phase 
Tested

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low-
Voltage 
Winding 

 
Measured 
Turn Ratio

 
 

Remarks 
 
 
 
 

48 

 
 
 
 

Yd5 

 

 
 

  
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2W-2U 
2U-2V 
2V-2W 

 
 
 

U1
U2

•
3
2

 

 
 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

49 

 
 
 
 

YNd7 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2V-2U 
2W-2V 
2U-2W 

 
 

 

32

1

•U

U
 

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

50 

 
 
 
 

Yd7 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2V-2U 
2W-2V 
2U-2W 

 
 
 

U1
U2

•
3
2

 

 
 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

51 

 
 
 
 

YNd11 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

1U-1N 
1V-1N 
1W-1N 

 
 
 

2U-2W 
2V-2U 
2W-2V 

 
 

 

32

1

•U

U  

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 

52 

 
 
 
 

Yd11 

 

 
 

 

 

 
 
 

U 
V 
W 

 
 
 

1V-1W 
1W-1U 
1U-1V 

 
 
 

1U-(1V+1W)
1V-(1W+1U)
1W-(1U+1V)

 
 
 

2U-2W 
2V-2U 
2W-2V 

 
 
 

U1
U2

•
3
2

 

 
 
 

No neutral 
accessible 

on wye 
winding 
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Notes to Table 5-6 

Transformer terminal markings for power transformers marked in accordance 
with requirements of Australian Standard 2374, Part 4-1982. 

Definition of Symbol Designations 

A2, B2, C2  External terminals on HV transformer winding (Ax, Bx, Cx). 

a2, b2, c2  External terminals on LV transformer winding (ax, bx, cx). 

N  External neutral terminal on HV transformer winding. 

n  External neutral terminal on LV transformer winding. 

*  Inaccessible neutral point on HV or LV transformer winding. 

HV  Nameplate voltage rating (line-to-line) of HV transformer 
winding. 

LV  Nameplate voltage rating (line-to-line) of LV transformer 
winding. 

A, B, C  Winding tested on HV side of transformer. 

a, b, c  Winding tested on LV side of transformer. 

IEC Vector Group Coding 

The letters indicate the three-phase winding connections; D, Y, and Z designate 
the HV side winding; d, y, and z designate the LV side winding. D and d 
represent a delta connection, Y and y represent a wye connection, and Z and z 
represent a zigzag connection. N and n indicate that the neutral point of a star or 
zigzag connected winding is accessible on the respective HV or LV side winding. 
The number indicates the phase displacement (lag) of the LV winding with 
respect to the HV winding in units of 30º. 

For example, 0 = 0º lag, 1 = 30º lag, 2 = 60º lag, 6 = 180º lag, 11 = 330º lag. 
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Additional Transformer Winding Identification 

External terminal markings for three-phase power transformers with more than 
two windings are as follows: 

3A, 3B, 3C Third winding (if any). 

4A, 4B, 4C Fourth winding (if any). 

If unable to find a corresponding diagram for a transformer with, for example, 
accessible neutral winding but can find the corresponding diagram for the same 
transformer with no neutral accessible winding, follow the test procedure for the 
transformer with no neutral accessible winding. In this case, specify the diagram 
number for the transformer with no neutral accessible winding and do not 
connect N or n lead to the neutral.  

As an example, if transformer winding connection is identical to Table 5-6 
Diagram 
No. 23 except the wye winding has an accessible neutral winding, perform test 
per Diagram 23. Do not connect N lead to the wye winding neutral terminal. 
The test results are identical and do not require any corrections. 
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Table 5-6. Transformer Winding Phase Relationship (Australian Std. 2374, Part 4 - 1982) 

Copyright 1999© Megger 
  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (HV) 

 
Low-Voltage  
Winding (LV) 

 
Phase 
Tested 

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low- 
Voltage 
Winding 

 
Measured 

Turn 
Ratio 

 
 

Remarks 

 
 
1 

 
 

1φ 
1ph0 

 

 
 

 

 
 

 

 
 

1φ 

 
 
⎯ 

 
 

A2 - A1 

 
 

a2 - a1 

 
HV
LV

 

 
 

Single-phase 
transformer 

 
 
2 

 
 

1φ 
1ph6 

 

 
 

 

 
 

 

 
 

1φ 

 
 
⎯ 

 
 

A2 - A1 

 
 

a1 - a2 

 
HV
LV

 

 
 

Single-phase 
transformer 

 
 
 
3 

 
 
 

Dd0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2 - A2 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV

 

 
 
 
⎯ 

 
 
 
 
4 

 
 
 
 

Dd6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2 - A2 

 
 
 

b1 - a1 
c1 - b1 
a1 - c1 

 
 
 

HV
LV

 

 
 
 
⎯ 

 
 
 
 
5 

 
 
 
 

Dyn1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - C2 
B2 - A2 
C2  - B2 

 
 
 

a2 - n 
b2 - n 
c2 - n 

 
 
 

HV
LV
• 3

 
 
 

Neutral 
accessible 

on wye 
winding 

 
 
 
 
6 

 
 
 
 

Dy1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - C2 
C2 - A2 
A2  - B2 

 
 
 

A2 - C2 
B2 - A2 
C2  - B2 

 
 
 

a2 -* 
b2 - * 
c2 - * 

 
 
 

HV
LV
• 3

 
 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 
7 

 
 
 
 

Dyn11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

a2 - n 
b2 - n 
c2 - n 

 
 
 

HV
LV
• 3  

 
 
 

Neutral 
accessible 

on wye 
winding 



M 
 
 

 
AVTMTTR310 Rev B Sept 2008 62 

Table 5-6. Transformer Winding Phase Relationship (Australian Std. 2374, Part 4 - 1982) 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (HV) 

 
Low-Voltage  
Winding (LV) 

 
Phase 
Tested 

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low- 
Voltage 
Winding 

 
Measured 

Turn 
Ratio 

 
 

Remarks 

 
 
 
 
8 

 
 
 
 

Dy11 

 

 
 

 

 
 

 
 

 
A 
B 
C 

 
 
 

B2 - C2 
C2 - A2 
A2  - B2 

 
 
 

A2 - B2 
B2 - C2 
C2 - A2 

 
 
 

a2 - * 
b2 - * 
c2 - * 

 
 
 

HV
LV
• 3  

 
 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 
9 

 
 
 
 

Dzn0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - C2 
C2 - A2 
A2  - B2 

 
 
 
A2 - (B2+C2) 
B2 - (C2+A2) 
C2 - (A2+B2) 

 
 
 

a4 - n 
b4 - n 
c4 - n 

 
 
 

1.5 HV
LV

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 

 
 
 
 

10 

 
 
 
 

Dz0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

a4 - b4 
b4 - c4 
c4 - a4 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

11 

 
 
 
 

Dzn6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - C2 
C2 - A2 
A2 - B2 

 
 
 

A2 - (B2+C2) 
B2 - (C2+A2) 
C2 - (A2+B2) 

 
 
 

n - a3 
n - b3 
n - c3 

 
 
 

1.5 HV
LV

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

12 

 
 
 
 

Dz6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2 - A2 

 
 
 

b3 - a3 
c3 - b3 
a3 - c3 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

13 

 
 
 
 

YNyn0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - N 
B2 - N 
C2  - N 

 
 
 

a2 - n 
b2 - n 
c2 - n 

 
 
 

HV
LV

 

 
 

Neutral 
accessible 
on HV & LV 

windings 
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Table 5-6. Transformer Winding Phase Relationship (Australian Std. 2374, Part 4 - 1982) 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (HV) 

 
Low-Voltage  
Winding (LV) 

 
Phase 
Tested 

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low- 
Voltage 
Winding 

 
Measured 

Turn 
Ratio 

 
 

Remarks 

 
 
 
 

14 

 
 
 
 

YNy0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - N 
C2 - N 
A2 - N 

 
 
 

A2 - N 
B2 - N 
C2  - N 

 
 
 

a2 - - * 
b2 - * 
c2  - * 

 
 
 

HV
LV

 

 
 

No 
accessible 

neutral on LV 
winding 

 
 
 
 

15 

 
 
 
 

Yyn0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 

on HV 
winding 

 
 
 
 

16 

 
 
 
 

Yy0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV

 

 
 

No neutral 
accessible  
on HV & LV 

windings 

 
 
 
 

17 

 
 
 
 

YNyn6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - N 
B2 - N 
C2 - N 

 
 
 

n - a1 
n - b1 
n - c1 

 
 
 

HV
LV

 

 
 

Neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

18 

 
 
 
 

YNy6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - N 
C2 - N 
A2 - N 

 
 
 

A2 - N 
B2 - N 
C2  - N 

 
 
 

* - a1 
* - b1 
* - c1 

 
 
 

 

 
 

No neutral 
accessible 

on LV 
winding 

 
 
 
 

19 

 
 
 
 

Yyn6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

b1 - a1 
c1 - b1 
a1 - c1 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 

on HV 
winding 
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Table 5-6. Transformer Winding Phase Relationship (Australian Std. 2374, Part 4 - 1982) 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (HV) 

 
Low-Voltage  
Winding (LV) 

 
Phase 
Tested 

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low- 
Voltage 
Winding 

 
Measured 

Turn 
Ratio 

 
 

Remarks 

 
 
 
 

20 

 
 
 
 

Yy6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

b1 - a1 
c1 - b1 
a1 - c1 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

21 

 
 
 
 

Yzn1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - C2 
B2 - A2 
C2  - B2 

 
 
 

a4 - n 
b4 - n 
c4 - n 

 
 
 

HV
LV
• 3

 
With or 
without 
neutral 

accessible 
on wye 
winding 

 
 
 
 

22 

 
 
 
 

Yz1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2- C2 
C2 - A2 
A2 - B2 

 
 
 

A2- (B2 +C2) 
B2 - (C2+A2) 
C2 - (A2+B2) 

 
 
 

a4 - b4 
b4 - c4 
c4 - a4 

 
 
 

HV
LV

•
3
2

 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

23 

 
 
 
 

Yzn11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - B2 
B2 - C2 
C2  - A2 

 
 
 

a4 - n 
b4 - n 
c4 - n 

 
 
 

HV
LV
• 3  

 
With or 
without 
neutral 

accessible 
on wye 
winding 

 
 
 
 

24 

 
 
 
 

Yz11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - C2 
C2   - A2 
A2  - B2 

 
 
 

A2 - (B2+C2) 
B2 - (C2+A2) 
C2 - (A2+B2) 

 
 
 

a4 - c4 
b4 - a4 
c4 - b4 

 
 
 

HV
LV

•
3
2

 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

25 

 
 
 
 

YNd1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - N 
B2 - N 
C2  - N 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV • 3

 
 

Neutral 
accessible 

on wye 
winding 
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Table 5-6. Transformer Winding Phase Relationship (Australian Std. 2374, Part 4 - 1982) 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (HV) 

 
Low-Voltage  
Winding (LV) 

 
Phase 
Tested 

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low- 
Voltage 
Winding 

 
Measured 

Turn 
Ratio 

 
 

Remarks 

 
 
 
 

26 

 
 
 
 

Yd1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - C2 
C2 - A2 
A2 - B2 

 
 
 

A2 -(B2+C2) 
B2 -(C2+A2) 
C2  -(A2+B2) 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV

•
3
2

 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

27 

 
 
 
 

YNd11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A2 - N 
B2 - N 
C2  - N 

 
 
 

a2 - c2 
b2 - a2 
c2 - b2 

 
 
 

HV
LV 3•

 
 

Neutral 
accessible  

on wye 
winding 

 
 
 
 

28 

 
 
 
 

Yd11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B2 - C2 
C2 - A2 
A2 - B2 

 
 
 

A2 -(B2+C2) 
B2 -(C2+A2) 
C2  -(A2+B2) 

 
 
 

a2 - c2 
b2 - a2 
c2 - b2 

 
 
 

HV
LV

•
3
2

 
 

No neutral 
accessible 

on wye 
winding 

 
 
 
 

29 

 
 
 
 

ZNd0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

b2 - c2 
c2 - a2 
a2 - b2  

 
 
 

A4 - N 
B4 - N 
C4 - N 

 
 
 

a2 - (b2+c2) 
b2 - (c2+a2) 
c2 - (a2+b2) 

 
 
 

HV
1.5 LV

 

 
 

Neutral 
accessible 
on zigzag 
winding 

 
 
 
 

30 

 
 
 
 

Zd0 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A4 - B4 
B4 - C4 
C4 - A4 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

31 

 
 
 
 

ZNd6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

b1 - c1 
c1 - a1 
a1 - b1 

 
 
 

A4 - N 
B4 - N 
C4 - N 

 
 
 

(b1+c1) - a1 
(c1+a1) - b1 
(a1+b1) - c1 

 
 
 

HV
1.5 LV

 

 
 

Neutral 
accessible 
on zigzag 
winding 
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Table 5-6. Transformer Winding Phase Relationship (Australian Std. 2374, Part 4 - 1982) 
Copyright 1999© Megger 

  Winding Connection   Winding Tested   
 

Diag 
No. 

IEC 
Vector 
Group 

 
High-Voltage  
Winding (HV) 

 
Low-Voltage  
Winding (LV) 

 
Phase 
Tested 

Winding 
Shorted 
By TTR 

High- 
Voltage 
Winding 

Low- 
Voltage 
Winding 

 
Measured 

Turn 
Ratio 

 
 

Remarks 

 
 
 
 

32 

 
 
 
 

Zd6 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A4  - C4 
B4 - A4 
C4 - B4 

 
 
 

b1 - a1 
c1 - b1 
a1 - c1 

 
 
 

HV
LV

 

 
 

No neutral 
accessible 
on zigzag 
winding 

 
 
 
 

33 

 
 
 
 

ZNy1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A4 - N 
B4 - N 
C4  - N 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV • 3

 
 

No 
accessible 

neutral on LV 
winding 

 
 
 
 

34 

 
 
 
 

Zy1 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B4 - C4 
C4 - A4 
A4 - B4 

 
 
 

A4 -(B4+C4) 
B4 -(C4+A4) 
C4  -(A4+B4) 

 
 
 

a2 - b2 
b2 - c2 
c2 - a2 

 
 
 

HV
LV

•
3
2

 
 

No neutral 
accessible 
on HV & LV 

windings 

 
 
 
 

35 

 
 
 
 

ZNy11 

 

 
 

 

 
 

 
 

 
A 
B 
C 

 
 
 
⎯ 
⎯ 
⎯ 

 
 
 

A4 - N 
B4 - N 
C4  - N 

 
 
 

a2 - c2 
b2 - a2 
c2 - b2 

 
 
 

HV
LV • 3

 
 

No 
accessible 

neutral on LV 
winding 

 
 
 
 

36 

 
 
 
 

Zy11 

 

 
 

 

 
 

 
 
 

A 
B 
C 

 
 
 

B4 - C4 
C4 - A4 
A4 - B4 

 
 
 

A4 -(B4+C4) 
B4 -(C4+A4) 
C4  -(A4+B4) 

 
 
 

a2 - c2 
b2 - a2 
c2 - b2 

 
 
 

HV
LV

•
3
2

 
 

No neutral 
accessible 
on HV & LV 

windings 
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6 
Operation 

General Operating Procedure 

Proceed only after reading and fully understanding Section 2, Safety, and setting 
up the test set as described. An operator who is familiar with the contents of this 
manual, the test setup, and the operation of the test set may follow the 
condensed operating instructions in the lid of the test set. 

EMERGENCY SHUTDOWN 
Press red EMERGENCY TEST OFF push button or switch 
power off. 

Description of Menus and Test Screens 

Data shown on the menus and test screens in Figures 6-1 through 6-16 are for 
illustrative purposes only. The TTR310 test set menus and test screens are 
operated by using the keypad on the front panel. On power up, a beep sounds, 
the test set performs a 
self-test check, and all hardware and software variables are initialized.  

NOTE: See also Figure 4-2 for Operational Flow Chart. 
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Opening Display Screen (Figure 6-1) 

The LCD then displays the opening screen (Figure 6-1) and a beep sounds as the 
test set performs a diagnostic self-check of the electronics. 

 

Figure 6-1 Opening Display Screen 

If any errors are detected, one of the following error messages will replace the 
SELF-TEST IN PROGRESS message on the screen and be accompanied by 
three short beeps. 

ANALOG OFFSET VOLTAGE HIGH 
ANALOG GAIN OUT OF TOLERANCE 

If either error message is displayed, return the instrument to Megger for repair. 
Refer to Repair section for instructions. If no errors are detected, the Main Menu 
screen (Figure 6-2) appears. 

 
M 

 
AUTOMATIC TRANSFORMER TURN RATIO TESTER 

 
VERSION: 01.01 

 
06/15/98   11:05 

 
SELF TEST IN PROGRESS 

 
COPYRIGHT 1998, ALL RIGHTS RESERVED 
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MAIN MENU Screen (Figure 6-2)  

After a successful self-test check, the main menu screen (Figure 6-2) appears. 

 
MAIN MENU 

DATE (M/D/Y) : 06/15/1998  14:15 
    
1 QUICK TEST SETUP TEST WINDING: 
2 FULL TEST SETUP   
3 RECALL CUSTOM SETTINGS * 7  H-X 
4 SYSTEM SETUP MENU  8  H-Y 
5 SAVED DATA MENU  9 CT 
6 PRINT HEADER   
    
TEST:002   ID nnnnnnnnnnnn  DIAG    

01 
1ph0 

TEST VOLTAGE:   AUTO   
H  NAMEPLATE VOLTAGE (L-L):    250000 
X  NAMEPLATE VOLTAGE (L-L):    50000 

    
ENTER SELECTION FROM KEYPAD 

Figure 6-2. Main Menu Screen 

 

DATE (M/D/Y): This line shows the current date and time. Date 
format is month/day/year. To change date/time, 
select 4 (SYSTEM SETUP MENU) and then 
select 2 (SET DATE(M/D/Y)/TIME) on the 
SYSTEM SETUP menu (see Figure 6-12). 

1 QUICK TEST SETUP: This setup provides a quick path for transformer 
testing. It requires minimum transformer nameplate 
information to be entered before testing. The test 
results displayed do not include the calculated ratio 
and ratio deviation values. 

2 FULL TEST SETUP: This setup requires entering main transformer 
nameplate information. The FULL TEST SETUP is 
used for obtaining full test information of a 
transformer. This setup may be saved and recalled 
later for future testing of the same or similar type 
transformers. In this case (RECALL CUSTOM 
SETTINGS), no additional information needs to be 
entered to start testing, other than the transformer 
serial number (TRANSFOMER ID) if desired. 
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3 RECALL CUSTOM 
SETTINGS: 

This option permits saving up to nine custom 
transformer settings. These saved custom transformer 
settings may be recalled and used for testing the same 
or similar type of transformer. 

4 SYSTEM SETUP MENU: This menu permits choice of language, transformer 
standard, test voltage, phase display units and setting 
of date and time. 

5 SAVED DATA MENU: The TTR310 saves up to 200 test results. This menu 
allows these readings to be recalled for viewing and 
uploading to a PC. 

6 PRINT HEADER: This option will print out a test report header to the 
printer, if connected. 

TEST WINDING: Selection 7, 8, and 9 allow an operator to choose the 
windings to be tested. Asterisk (*) indicates last 
selection used. See description of the following 
screens for more details. 

Test parameters shown on the bottom of the main menu screen are from the last test 
performed. 
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QUICK TEST SETUP Screen (Figure 6-3) 

If 1 (QUICK TEST SETUP) is selected on the main menu, the QUICK TEST 
SETUP screen (Figure 6-3) appears. 

QUICK TEST SETUP 
 
1   TRANSFORMER ID:   nnnnnnnnnnnn 
 
 
2   TRANSFORMER TYPE:   DIAG  01     1ph0 
 
 
3   START TEST 
 
 
4   MAIN MENU 
 
 

ENTER SELECTION FROM KEYPAD 

Figure 6-3. Quick Test Setup Screen 

1 TRANSFORMER ID: This selection allows you to enter up to a 12-character 
alphanumeric identification of a transformer. Skip this 
step if you do not want to enter this information. When 
selected, the screen appears the same as Figure 6-3 
except for a message at bottom of screen: ENTER UP 
TO 12 CHARACTER ID. USE * TO SELECT 
LETTER. A cursor will blink on the line next to 
TRANSFORMER ID. 

2 TRANSFORMER TYPE: This selection is used to enter the diagram number 
(vector group) of the transformer to be tested. This 
diagram number must be entered for testing any 
transformer windings (see selections 7, 8, 9 on the Main 
Menu screen). When 2 (TRANSFORMER TYPE) is 
selected, the screen appears the same as Figure 6.3 
except for message at bottom of screen: ENTER 
TRANSFORMER DIAGRAM NUMBER. REFER TO 
TABLE ON INSTRUCTION CARD. Cursor will blink 
on the line next to TRANSFORMER TYPE (in place of 
“DIAG 01 1ph0”). 

3 START TEST: This selection initiates testing of a transformer. See 
Figure 6-4 for the next screen displayed (Initial Quick 
Test Result Screen). 

4 MAIN MENU:  This selection returns you to the main menu screen, 
Figure 6-2. 
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Quick Test Result Screens (Figure 6-4 and Figure 6-5) 

If 3 (START TEST) is selected on the QUICK TEST SETUP menu, Figure 6-3, 
the initial quick test result screen shown in Figure 6-4 appears. This screen is 
displayed during testing of a transformer. 

 
THREE PHASE TRANSFORMER TEST 

TEST:   nnn   ID:A13579CV0246 DIAG  NN  Ddnnn 
        

TEST VOLTAGE:      80V    
  A B C  
RATIO 
      
PHASE (min) 
Iexc (mA) 

        
TEST IN PROGRESS 

PRESS EMERGENCY TEST OFF BUTTON 
TO STOP TEST 

Figure 6-4. Initial Quick Test Result Screen 

The TEST IN PROGRESS message indicates that the TTR310 test set is 
performing a test. The test may be interrupted by pressing the EMERGENCY 
TEST OFF button, located on the front panel. When pressed, the 
EMERGENCY TEST OFF switch is locked in the off position. To reset the 
switch, twist the button in the direction indicated by the arrows. When the test is 
completed, the final quick test result screen shown in Figure 6-5 appears. 

If abnormal operating conditions occur during testing phase B or C of a three-
phase transformer, an error message (refer to Error Messages section) will appear 
on the bottom of the screen followed by the message “PRESS ANY KEY TO 
CONTINUE.” In this case, if any key is pressed, the following message will 
appear on the bottom of the screen:  

“Select  1 – REPEAT TEST   2 – CONTINUE    3 – ABORT TEST” 

If REPEAT TEST is selected, the test set will re-test phase B or C. 

If CONTINUE is selected, the test set will start testing of phase C (if an error 
message appeared during phase B testing).  

If ABORT TEST is selected, the Main Menu screen will appear. If one of these 
error messages appears, verify the abnormal condition by taking a repeat 
measurement before attempting to take any corrective action. If an error message 
appears during phase A testing, and repeat measurement is still bad, it is 
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impossible to continue testing of the transformer, and troubleshooting procedure 
should be started by testing each phase of the three-phase transformer separately 
as a single phase transformer. 

 
THREE PHASE TRANSFORMER TEST 

TEST:   nnn   ID:A13579CV0246 DIAG  nn   Ddnnn 
        

TEST VOLTAGE:   80V     
  A  B  C  
RATIO  12.379  12.354  12.287  
 
PHASE (min)  4.8  5.1  2.3  
        
Iexc (mA)  2.6  2.9  2.2  

 
 

 SELECT:  1-PRINT   2-STORE   3-NEXT TEST 
4-REPEAT TEST   5-MAIN MENU  

Figure 6-5. Final Quick Test Result Screen 

1 PRINT: This selection allows the test result to be printed out (on 
an optional printer or uploaded to PC. 

2 STORE: This selection allows the test result to be saved in 
memory for future viewing and/or printing and/or 
uploading to PC. 

3 NEXT TEST: When selected, the QUICK TEST SETUP screen, 
Figure 6-3, appears. You may change connections and 
continue testing with the same transformer (for example, 
with a different tap of the high voltage winding) or you 
may start testing a new transformer. 

4 REPEAT TEST: This selection allows you to repeat the last test. 

5 MAIN MENU: This selection brings back the MAIN MENU screen 
(Figure 6-2). 
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FULL TEST SETUP 1 Screen (Figure 6-6) 

If 2 (FULL TEST SETUP) is selected on the main menu, the FULL TEST 
SETUP 1 screen (Figure 6-6) appears. 

 

Figure 6-6. FULL TEST SETUP 1 Screen 

The last tested transformer information (previously entered) is displayed on the 
screen. 

1 CONTINUE: This selection brings up the FULL TEST SETUP 2 screen 
(Figure 6-7). 

2 TRANSFORMER ID: This selection allows you to enter up to a 12 character 
alphanumeric identification of a transformer. Skip this step 
if you do not want to enter this information. When 
selected, the screen appears the same as Figure 6-6 except 
for a message at bottom of screen: ENTER UP TO 12 
CHARACTER ID. USE * TO SELECT LETTERS. A 
cursor will blink on the line next to TRANSFORMER ID. 

3 TRANSFORMER 
TYPE: 

This selection is used to enter the diagram number (vector 
group) of the transformer to be tested. This diagram 
number must be entered for testing a transformer. Diagram 
numbers for the most common types of transformers are 
included on the instruction cards in the lid of the TTR310 
test set. When selected, the screen appears the same as 
Figure 6-6, except for the message at bottom of screen: 
ENTER TRANSFORMER DIAGRAM NUMBER, 
REFER TO TABLE ON INSTRUCTION CARD. A 
cursor will blink on the line next to TRANSFORMER 
TYPE. 

FULL TEST SETUP 1 
 
 

1. CONTINUE 
2. TRANSFORMER ID:   nnnnnnnnnnnn 
3. TRANSFORMER TYPE: DIAG  nn Ddnnn 
4. H NAMEPLATE VOLTAGE (L-L):  250000 
5. NO. OF H TAPS:  5 
6. NOMINAL VOLTAGE H TAP NO:   3 
7. HIGH VOLTAGE H TAP NO:   1 
8. % DIFFERENCE/TAP   2.5 
9. MAIN MENU 

 
 

ENTER SELECTION FROM KEYPAD
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4 H NAMEPLATE 
VOLTAGE (L-L): 

This selection is used to enter the nameplate high voltage 
(H) rating of the transformer to be tested (L-L stands for 
line to line). The transformer under test nameplate high 
voltage is used to calculate the transformer turn ratio when 
test winding 7 (H-X) or 8 (H-Y) is selected on the Main 
Menu screen (see Figure 6-2). When test winding 9 CT is 
selected on the Main Menu screen (see Figure 6-2), entry 4 H 
NAMEPLATE VOLTAGE (L-L) is replaced by 4 
PRIMARY CURRENT (A), and selections 5, 6, 7, 8 of the 
FULL TEST SETUP 1 screen will go off. In this case 
selection 4 PRIMARY CURRENT (A) is used to enter the 
nameplate primary current of a current transformer tested. 

5 NO. OF H TAPS: This selection is used to enter the number of taps on the 
high side (H) of the transformer to be tested. If the high side 
winding does not have any taps, enter 0 (selections 6, 7, and 
8 will go off.) 

6 NOMINAL 
VOLTAGE H TAP NO:

This selection is used to enter the tap number of the nominal 
voltage of the high side (H) of the transformer. 

7 HIGH VOLTAGE H 
TAP NO: 

This selection is used to enter the tap number of the  highest 
input voltage of the transformer. 

8 % 
DIFFERENCE/TAP 

This selection is used to enter the high voltage difference (in 
percent) per tap. Use the following formula to calculate this 
parameter: 

 ( ) %100
1

minmax ×
−×

−
nV

VV

Hnameplate

HH , 

Where: n = number of H taps, 

VHMAX = maximum voltage at H winding taps, 
VHMIN = minimum voltage at H winding taps, 
VHNAMEPLATE = nominal voltage at H winding taps. 
If a nameplate has information on total change of voltage in 
percent (for example, +/- 10% from nominal voltage), the 
following formula may be used to calculate the % difference 
per tap:  

(Total % of voltage change) ÷ (n – 1), 

 Where n = number of H taps. 

Note: The aforementioned calculations are true only if a 
transformer has the same voltage change per tap.  

9 MAIN MENU: This selection returns you to the MAIN MENU screen, 
Figure 6-2. 
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FULL TEST SETUP 2 Screen (Figure 6-7) 

If 1 is selected on the FULL TEST SETUP 1 screen, the FULL TEST SETUP 2 
screen (Figure 6-7) appears. 

 

Figure 6-7. FULL TEST SETUP 2 Screen 

The previously entered information from the last transformer tested is displayed 
on the screen. 

1 CONTINUE: This selection brings up the FULL TEST SETUP 3 
screen shown in Figure 6-8. 

2 X NAMEPLATE 
VOLTAGE (L-L): 

This selection is used to enter the nameplate low voltage 
rating of the transformer to be tested (L-L stands for 
line to line). The transformer-under-test nameplate low 
voltage is used to calculate the transformer turn ratio. 

When test winding 8 (H-Y) is selected on the Main 
Menu screen (see Figure 6-2), entry 2 X NAMEPLATE 
VOLTAGE (L-L) is replaced by 2 Y NAMEPLATE 
VOLTAGE (L-L). In this case this selection is used to 
enter the tertiary (Y) nameplate low voltage rating of the 
transformer to be tested (L-L stands for line to line). 

When test winding 9 CT is selected on the Main Menu 
screen (see Figure 6-2), entry 2 X NAMEPLATE 
VOLTAGE (L-L) is replaced by 2 SECONDARY 
CURRENT (A), and selections 3, 4, 5, 6, of the FULL 
TEST SETUP 2 screen will go off. In this case selection 
2 SECONDARY CURRENT (A) is used to enter the 
nameplate secondary current of a current transformer 
tested. 

 

FULL TEST SETUP 2 
 
 

1 CONTINUE 
2 X NAMEPLATE VOLTAGE (L-L):  5000 
3 NO. OF H TAPS:   33 
4 NOMINAL VOLTAGE X TAP NO:   17 
5 HIGH VOLTAGE X TAP NO:   33    OR 16R 
6 % DIFFERENCE/TAP   0.625 
7 PAUSE BETWEEN PHASES:   NO 
8 SAVE CUSTOM SETTINGS 
9 PREVIOUS MENU 
10  

 
ENTER SELECTION FROM KEYPAD 
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3 NO. OF  X TAPS: This selection is used to enter the number of taps on the 
low side (X) of the transformer. If the low side winding 
does not have any taps, enter 0 (selections 4, 5, and 6 will 
go off). 

4 NOMINAL VOLTAGE X 
TAP NO: 

This selection is used to enter the tap number of the 
nominal output voltage of the low side (X) of the 
transformer. 

5 HIGH VOLTAGE X TAP 
NO: 

This selection is used to enter the tap number of the 
highest output voltage of the transformer. 

6 % DIFFERENCE/TAP This selection is used to enter the low voltage difference 
(in percent) per tap. Use the following formula to 
calculate this parameter:  

( ) %100
1
×

−×
−

nV
VV

XNOMINAL

XMINXMAX , 

Where n = number of X taps, 
VXMAX = maximum voltage at X winding taps, 
VXMIN = minimum voltage at X winding taps, 
VXNAMEPLATE = nominal voltage at X winding taps. 

If a nameplate has information on total change of voltage 
in percent (for example, +/- 10% from nominal voltage), 
the following formula may be used to calculate the % 
difference per tap:  

(Total % of voltage change) ÷ (n – 1), 

 Where n = number of X taps. 

Note: The aforementioned calculations are true only 
if a transformer has the same voltage change per tap.

7 PAUSE BETWEEN 
PHASES: 

For this selection, there are two choices ⎯ NO or YES. 
If NO is chosen, the TTR310 will test all three windings 
and display the test results as shown in Figure 6-9 
(THREE PHASE TRANSFORMER TEST result 
screen). If YES is chosen, the TTR310 will test the first 
phase of a transformer and display the test results as 
shown in Figure 6-10 (Phase A Test Result Screen). 

8 SAVE CUSTOM 
SETTINGS: 

This selection allows to save up to nine custom 
transformer settings. See Figure 6-15, Recall (or Save) 
Custom Transformer Settings Screen. 

9 PREVIOUS MENU: This selection returns you to the FULL TEST SETUP 1 
screen (Figure 6-6). 
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FULL TEST SETUP 3 Screen (Figure 6-8) 

If 1 is selected on the FULL TEST SETUP 2 screen, the FULL TEST SETUP 3 
screen appears (Figure 6-8). 

 

Figure 6-8. FULL TEST SETUP 3 Screen 

The test number, ID and diagram are shown on the first line. 

Selections 1 and 2 allow you to test any pairs of H and X taps. If the transformer 
under test does not have any taps, only selections 3, 4, and 5 will be displayed on 
the screen. 
If 3 (START TEST) is selected, see Figure 6-4 for the next screen displayed. 
The % DEVIATION heading will also be shown on the screen. 

1 H TAP TO BE TESTED: This selection is used to enter the H tap number to be 
tested when test winding 7 H-X or 8 H-Y is selected on 
the Main Menu screen (see Figure 6-2). 

When test winding 9 CT is selected on the Main Menu 
screen this entry will go off. 

2 X TAP TO BE TESTED: This selection is used to enter the X tap number to be 
tested when test winding 7 H-X is selected on the Main 
Menu screen (see Figure 6-2). When test winding 
8 (H-Y) is selected on the Main Menu screen, entry 2 X 
TAP TO BE TESTED is replaced by 2 Y TAP TO BE 
TESTED. When test winding 9 CT is selected on the 
Main Menu screen (see Figure 6-2), this entry will go off. 

FULL TEST SETUP 3 
TEST:   nnn   ID:A13579CV0246 DIAG  nn  Ddnnn 

 
1   H TAP TO BE TESTED: 3 
 
2   X TAP TO BE TESTED: 3 
 
3   START TEST 
 
4   PREVIOUS MENU 
 
5 MAIN MENU 
 
 

ENTER SELECTION FROM KEYPAD 
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3 START TEST: This selection initiates testing of a transformer. If 
selected, the screen shown in Figure 6-4 will appear. 

4 PREVIOUS MENU: This selection will return you to the FULL TEST 
SETUP 2 screen (Figure 6-7). 

5 MAIN MENU: This selection returns you to the MAIN MENU screen 
(Figure 6-2). 
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Transformer Test Result Screens (Figure 6-9 and Figure 6-10) 

When test is completed with NO pauses between phases chosen (selection 7, 
Figure 6-7) the test results are displayed as in Figure 6-9 (Three-Phase 
Transformer Test Results Screen). 

THREE PHASE TRANSFORMER TEST 
TEST:   nnn   ID:A13579CV0246    DIAG  nn  Ddnnn 

TAPS TESTED: 3   -   16R   
HIGH VOLTAGE:  25000 X VOLTAGE:   5000 
CALCULATED TURNS RATIO:   5.000 
TEST VOLTAGE:      80V   
 A B C 
RATIO 5.102 5.015 4.986 
% DEVIATION  2.04 0.24 0.30 
PHASE (min)  1.2 2.4 1.8 
Iexc (mA) 20.6 10.5 7.78 

    
    

SELECT:   1-PRINT   2-STORE   3-NEXT TEST 
 4-REPEAT TEST   5-MAIN MENU 

Figure 6-9. Three-Phase Transformer Test Result Screen 

 

1 PRINT: This selection prints out the test results. 

2 STORE: This selection stores the test results. 

3 NEXT TEST: This selection brings up the FULL TEST SETUP 3 
screen (Figure 6-8). At this point you may specify 
another pair of transformer taps to be tested. 

4 REPEAT TEST: This selection repeats the last test. If the transformer 
under test does not have any taps the Main Menu screen 
appears. 

5 MAIN MENU: This selection displays the MAIN MENU (Figure 6-2). 

When test is completed with pauses between phases selected (YES chosen on 
selection 7, Figure 6-7), the screen shown in Figure 6-10 (Phase A Test Result 
Screen) appears after phase A test is complete. 

If abnormal operating conditions occur during testing phase B or C of a three-
phase transformer, an error message (refer to Error Messages section) will appear 
on the bottom of the screen followed by the message “ PRESS ANY KEY TO 
CONTINUE.” In this case, if any key is pressed, the following message will 
appear on the bottom of the screen:  
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“Select  1 – REPEAT TEST   2 – CONTINUE      3 – ABORT TEST” 

If REPEAT TEST is selected, the test set will re-test phase B or C. 

If CONTINUE is selected, the test set will start testing of phase C (if an error 
message appeared during phase B testing).  

If ABORT TEST is selected, the Main Menu screen will appear. 

If one of these error messages appears, verify the abnormal condition by taking a 
repeat measurement before attempting to take any corrective action. If an error 
message appears during phase A testing, and repeat measurement is still bad, it is 
impossible to continue testing of the transformer, and troubleshooting procedure 
should be started by testing each phase of the three-phase transformer separately as 
a single phase transformer. 

 
THREE PHASE TRANSFORMER TEST 

TEST:   nnn   ID:A13579CV0246    DIAG  nn  Ddnnn 
TAPS TESTED: 3   -   16R   
H VOLTAGE:  25000 X VOLTAGE:   5000 
CALCULATED TURNS RATIO:   5.000 
TEST VOLTAGE:      80V   
 A B C 
RATIO 5.102   
% DEVIATION  2.04   
PHASE (min)  1.2   
Iexc (mA) 20.6   

    
    

  
SELECT:   1-REPEAT TEST    2 CONTINUE 

Figure 6-10. Phase A Test Result Screen 

1 REPEAT TEST: This selection allows repeat testing of the same phase 
(last phase tested, A,B, or C). Refer to following 
paragraphs. 

2 CONTINUE: This selection will initiate testing of the next phase. 
Refer to following paragraphs. 

You may repeat testing of the phase (select 1 REPEAT) or continue testing the 
transformer (select 2 CONTINUE). If 2 is selected, phase B will be tested. After 
completion of the phase B testing, the test result will be displayed next to phase 
A test results. The same two selections (1 REPEAT and 2 CONTINUE) are 
shown on the screen. Selection 1 allows repeating of the phase B testing. 
Selection 2 starts the phase C testing.  
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After completion of the phase C testing, the test result will be displayed next to 
phase B test results. The same two selections are shown on the screen. Selection 
1 allows repeating of the phase C testing. Selection 2 will bring up the five 
selections shown in Figure 6-9. 

If abnormal operating conditions occur during testing a transformer, an error 
message will appear on the screen. Refer to Error Messages section. If one of 
these messages appears, verify the abnormal condition by taking a repeat 
measurement before attempting to take any corrective action. 
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Main Menu Screen When a Custom Transformer Setting Recalled 
(Figure 6-11) 

After selection of a custom transformer setting, the MAIN MENU will appear as 
shown in Figure 6-11. It will display the main parameters of the saved custom 
settings, including the H and X nameplate voltages, the diagram number and the 
test set voltage. The ID number will be blank. The test number shows the 
number of the next test to be run. 

 
MAIN MENU 

DATE (M/D/Y) : 06/15/1998  14:15 
    
1 QUICK TEST SETUP TEST WINDING: 
2 FULL TEST SETUP   
3 RECALL CUSTOM SETTINGS * 7  H-X 
4 SYSTEM SETUP MENU  8  H-Y 
5 SAVED DATA MENU  9 CT 
6 PRINT HEADER   
    
TEST:002   ID nnnnnnnnnnnn  DIAG    01 1ph0 
    TEST VOLTAGE:   AUTO   
    H  NAMEPLATE VOLTAGE (L-L):    250000 
    X  NAMEPLATE VOLTAGE (L-L):    50000 
    

ENTER SELECTION FROM KEYPAD 

Figure 6-11. The Main Menu Screen After Selection of a Custom Transformer Setting 

Full Test Setup 1, 2, and 3 screens will display the custom transformer setting 
recalled. 
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SYSTEM SETUP Menu (Figure 6-12) 

When selection 4 (SYSTEM SETUP MENU) on the MAIN MENU is chosen, 
the SYSTEM SETUP MENU screen appears as shown in Figure 6-12. 

 

Figure 6-12. SYSTEM SETUP Screen 

1 LANGUAGE: This selection allows a choice of six languages. See 
Figure 6-13 for LANGUAGE screen. 

2 SET DATE/TIME: This selection is for entering the date and time. Year has 
four-digit representation (mm/dd/yyyy). 

3 STANDARD: This selection is for entering the desired transformer 
standard. Three transformer standards are available to 
select from: ANSI, IEC, or AS (Australia Standard). 

4 TEST VOLTAGE: This selection is for entering the desired test voltage. 
There are four selections available: 

AUTO ⎯ the TTR310 will automatically test at the 
highest allowable excitation voltage (80 V, 40 V, or 8 V), 
depending on the transformer excitation current 
measured. 

80 V ⎯ the test voltage is 80 Volts. 

40 V ⎯ the test voltage is 40 Volts. 

  8 V ⎯ the test voltage is 8 Volts. 

SYSTEM SETUP 
 

 
1   LANGUAGE:   ENGLISH 
 
2   SET DATE (M/D/Y)/TIME:  03/16/1998   11:45 
 
3   STANDARD:    ANSI 
 
4   TEST VOLTAGE:    AUTO 
 
5   PHASE DISPLAY:    DEGREES 
 
6   MAIN MENU 
 

ENTER SELECTION FROM KEYPAD 
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5 PHASE DISPLAY: This selection allows a choice of the phase display units: 
DEGREES, CENTIRADS or NONE. If DEGREES is 
selected, any phase test results below 1 degree will be 
displayed in minutes. If CENTIRADS is selected, the 
phase test results will be displayed in centiradians (1 
centiradian = 0.573 degrees). If NONE is selected, the 
phase test results will not be displayed. 

6 MAIN MENU: This selection returns you to the MAIN MENU screen. 

LANGUAGE Screen (Figure 6-13) 

Use this screen to select a language. Text on all screens except for the opening 
display screen will appear in the language chosen.  

 

Figure 6-13. Language Screen 

LANGUAGE 
 
 
1   ENGLISH 
 
2   FRANCAISE 
 
3   ESPANOL 
 
4   PORTUGUESA 
 
5   DEUTSCH 
 
6   ITALIANA 
 

ENTER SELECTION FROM KEYPAD 



M 
 
 

 
AVTMTTR310 Rev B Sept 2008 86 

SAVED DATA Screen (Figure 6-14) 

When 5 (SAVED DATA MENU) is selected on the MAIN MENU screen 
(Figure 6-2), the SAVED DATA screen appears as shown in Figure 6-14. 

  

Figure 6-14. SAVED DATA Screen 

Use this menu to view, delete, or transfer to a PC the saved test results. 

1 VIEW READINGS: This selection allows you to specify the first test number 
to view and then (on prompt) the number of tests to 
view. The test results will be displayed on the screen. A 
prompt line will show three prompts: 0 NEXT, 1 
PRINT, and 2 EXIT. Select NEXT to view the next 
reading in numerical order; select PRINT to print test 
results; Select EXIT to return to SAVED DATA screen.

2 DELETE LAST 
READING: 

This selection deletes from memory the last reading 
saved. 

3 DELETE ALL 
READINGS: 

This selection deletes all readings from memory. 

4 TRANSFER READINGS 
TO PC: 

This selection allows to select which test results to 
transfer to a PC. 

5 MAIN MENU: This selection returns you to the MAIN MENU screen 
(Figure 6-2). 

 

SAVED DATA 
 
1   VIEW READINGS 
 
2   DELETE LAST READING 
 
3   DELETE ALL READINGS 
 
4   TRANSFER READINGS TO PC 
 
5   MAIN MENU 
 

ENTER SELECTION FROM KEYPAD 
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Recall (or Save) Custom Transformer Settings (Figure 6-15) 

If 3 (RECALL CUSTOM SETTINGS) is selected on the MAIN MENU screen 
(Figure 6-2), the RECALL CUSTOM SETTINGS screen appears as shown in 
Figure 6-15. 

If 8 (SAVE CUSTOM SETTINGS) is selected on the FULL TEST SETUP 2 
menu (Figure 6-7), the screen appears the same as in Figure 6-15 except that the 
headline will be changed to SAVE CUSTOM SETTINGS. 

RECALL CUSTOM SETTINGS 
 
 DIAG TYPE H VOLTAGE X VOLTAGE 
1 03 Dd0 250000 20000 
2     
3 12 Dyn5 67000 12000 
4     
5     
6     
7     
8     
9     
     
0 PREVIOUS MENU  
 ENTER SELECTION FROM KEYPAD 

Figure 6-15. Recall (or Save) Custom Settings Screen 

The following message will be displayed if a selection without data is recalled: 

NO DATA IN SELECTED CUSTOM SETTING, PRESS ANY KEY TO 
CONTINUE. 

The following message will be displayed if your selection to save data already 
contains data: 

CUSTOM SETTING 1 (i.e.) HAS DATA! OVERWRITE? 0 = YES, 1 = NO 

Saved data will be overwritten by selecting YES. 

Selecting NO will return you to the SAVE CUSTOM SETTINGS screen. 
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Error Messages 
When an error message appears in the transformer test result screen indicating an 
abnormal operating condition, verify the condition by taking a repeat 
measurement before attempting to take any corrective action. Also, refer to the 
Troubleshooting section for malfunctions and possible causes.  

Open connections, wrong connections, open windings, shorted windings, high 
resistance windings, other abnormal transformer problems, or a combination of 
these may cause a large deviation from normal turn ratio or indicate an unusual 
message. The unusual operating conditions may be caused by an abnormal 
leakage reactance or capacitive coupling within the transformer windings. If 
abnormal operating conditions occur during transformer testing, the following 
error messages will appear on the quick test result screen and the transformer 
test result screen, accompanied by three short beeps. 

CHECK CONNECTIONS 

This message indicates that the transformer is not connected to the test set. The 
message may be caused by poor connection of one of the test leads, as well. 

PHASE A (or B, or C) EXCITATION CURRENT TOO HIGH  

This message indicates that excitation current exceeds 500 mA. Excitation 
current can be reduced by using lower test voltages (40 V or 8 V). 

TURNS RATIO TOO LOW, <0.8 

This message shows that a transformer under test turn ratio is less than 0.8. The 
TTR310 is not designed to test a transformer turn ratio under 0.8. 

PHASE A (or B, or C) TURNS RATIO TOO HIGH 

This message shows that a transformer under test turn ratio is higher than 10,000 
(if 80 V or 40 V is used) or is higher than 4,000 (if 8 V is used). The message may 
be caused by poor connection of one of the test leads, as well. 

CHECK PHASE A (or B, or C) CONNECTIONS, REVERSED 

This message is caused by incorrect connection of the H and X leads. The H and 
X leads have either been reversed or the test transformer connections or 
markings do not comply with the requirements of ANSI, IEC, or the Australian 
standard. The message may be caused by wrong diagram number specified, as 
well. 



 
OPERATION 

 

 
AVTMTTR310 Rev B Sept 2008 89

CHECK PHASE A (or B, or C) POLARITY 

This message shows that the H or X test leads are incorrectly connected or the 
test transformer connections or markings do not comply with the requirements 
of ANSI, IEC, or the Australian standard. 

If self-test fails, one of the following error messages will appear on the opening 
display screen and you should return the test set to Megger for repair. Refer to 
Repair section for instructions. 

ANALOG OFFSET VOLTAGE HIGH 

ANALOG GAIN OUT OF TOLERANCE 

CAN NOT DETECT FLASH RAM 

FAILED PROGRAM CODE CHECK 

PLEASE SHUT DOWN AND CHECK THE MANUAL 

CHECKING ALTERA: GOOD (BAD) 

CHECKING DISPLAY: GOOD (BAD) 

CHECKING RAM: GOOD (BAD) 

Remote Control Operation for LTC Testing 

Use the remote control mode of the TTR310 for load tap changer (LTC) testing 
in QUICK MODE of operation. The remote control mode provides two-way-
communication between the operator and the TTR310, allowing you to stay 
close to an LTC, change taps, and initiate the test routine.  

Connect the hand-held control unit, Megger p/n 30915-220, to the RS232 port 
of the TTR310. At power-up, the TTR310 detects that the hand-held control 
unit is connected and automatically sets the QUICK MODE operation. 

To start testing specify the transformer diagram number and press 3 (START 
TEST) at QUICK MODE menu.  The remote control unit pushbutton lamp will 
go on. Now an operator may come to the remote location, set, for example, LTC 
to the desired position and then depress the remote control unit pushbutton for 
a short time, then release it. The pushbutton lamp extinguishes until the TTR310 
is ready for the next test. When the current testing is complete, the test results 
are automatically saved, the test ID is advanced to the next number, the 
pushbutton lamp lights, and the TTR310 test set is ready for the next remote 
test.  
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Use with the Optional Printer 
If you are using the optional printer, plug the printer cable into the 
RS232/PRINTER receptacle on the TTR310 test set and turn it on. A separate 
manual is supplied with the printer. Refer to it for specific information about 
how to connect, operate, and care for the printer.  

Select 6 PRINT HEADER on the main menu to print out a test report header. 
Select 1 PRINT on the final quick test result screen or the three-phase 
transformer test result screen to print out test results. A sample printout is 
shown in Figure 6-16a, 6-16b, and 
6-16c. 

M 
AUTOMATIC TRANSFORMER TURN RATIO TESTER 

CATALOG NO. TTR310 
________________________________________________ 

 
TRANSFORMER TEST REPORT 

COMPAMY:______________________________________ 
SUBSTATION:____________________________________ 
MANUFACTURER:________________________________ 
TRANSFORMER RATING:________________kVA/MVA 
AMBIENT TEMPERATURE:________________________ 
RELATIVE HUMIDITY:____________________________ 
TTR S/N:__9901245_______________________________ 
OPERATOR (S):___________________________________ 
_________________________________________________ 
COMMENTS/NOTES: 
 

Figure 6-16a.  Sample Test Report Header 

DATE (M/D/Y) : 06/01/1999  12:25 
TEST:  002 
TRANSFORMER ID:  12A-76M/2 
TYPE:  SINGLE PHASE TRANSFORMER  1ph0 
TAPS TESTED:  3 – 17 
H VOLTAGE:  10000 
X VOLTAGE:  10000 
CALCULATED TURNS RATIO:  1.0000 
TEST VOLTAGE:  8V 
    
RATIO 1.0013   
% DEVIATION 0.13   
PHASE(min) -14.7   
Iexc(ma) 0.03   

Figure 6-16b.  Sample Single Phase Test Report 



 
OPERATION 
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DATE (M/D/Y) : 06/01/1999  1:25 
TEST:  003 
TRANSFORMER ID:  CHQ12-5899D 
TYPE: THREE PHASE TRANSFORMER  Dd6 
TAPS TESTED:  3 - 16L 
H VOLTAGE:  250000 
X VOLTAGE:  50000 
CALCULATED TURNS RATIO:  5.0000 
TEST VOLTAGE:  80V 
 A B C 
RATIO 5.006 4.998 5.011 
% DEVIATION 0.12 -0.04 0.22 
PHASE(min) 5.3 6.5 7.9 
Iexc(ma) 8.5 9.1 7.6 
     

Figure 6-16c.  Sample Three-Phase Test Report 
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Use with the Optional Inverter 

The TTR310 may be used with the optional inverter. This feature is important 
when the mains is not accessible or it is not reliable (the voltage variations are 
too high, too noisy, or frequency changes are not acceptable.) In this case, the 
optional inverter XP 125 may be used as a reliable source of true sine wave 
power supply. The XP 125 inverter provides both 120 V ac and 230 V ac at 
frequency 50 Hz or 60 Hz. The XP 125 uses a car battery as a source of input 
power. See Section 8 for ordering information. 

To operate, simply plug the cigarette lighter adaptor in and plug in the TTR310 
test set. Keep your vehicle running when operating the inverter. The XP 125 
inverter will source up to 125 W load. To maximize the performance of the 
inverter, keep the battery and other electrical connectors clean and free of 
corrosion. Always unplug the inverter when it is not in use. The inverter has 
numerous built-in protection features which prevent internal damage. The most 
important of these features include: 

1. Low battery voltage – if the battery voltage at the inverter drops below the 
under voltage cut-off (10.6 V dc), the inverter will automatically shut off. 
When battery voltage increases to 95 % of nominal battery voltage (13. 8 V 
dc), the inverter will restart. 

2. High battery voltage – if the battery voltage input rises above the over 
voltage cut-off (16.5 V dc), the inverter will automatically shut off. When the 
battery voltage input drops back to the normal voltage range, it will turn itself 
back on. 

3. Over-temperature – if the inverter gets too hot due to high ambient 
temperature, blocked air flow or overload conditions it will automatically 
shut off. However, when the inverter reaches an acceptable temperature it 
will automatically turn back on. 

4. Overpower – the inverter will source up to it’s maximum power rating, 
however, if the load requires more than this, the output voltage will be 
lowered to supply no more than it’s maximum power. In this way, the 
maximum power from the inverter is reduced to a safe amount. 
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7 
TTR 300 Series PowerDB Lite User Manual 

Introduction 

PowerDB Lite is a free, but limited capability, version of the PowerDB software 
tool that is designed specifically to control and/or extract data from Megger 
instruments.  The primary difference between PowerDB Lite and PowerDB is 
that PowerDB is designed to work with all manufacturers’ equipment and has 
field and office synchronization capabilities.  PowerDB Lite will present your test 
data into a professional looking data form that can be sent to a printer or .pdf file 
distiller such as PDF995.     

PowerDB Lite allows you to use a sub-set of the standard PowerDB forms that 
are appropriate for specific Megger instruments.  PowerDB Lite detects the 
instrument and enables the appropriate form(s).  Data can be entered on-screen 
or captured directly while using the test instrument.  Completed data forms can 
be saved as files to your computer. 

Minimum Recommended System  

 Operating System: Windows 2000 or later 

 RAM:  64 MB RAM minimum, 512+ MB RAM 
recommended  

 Processor: 300 MHz Pentium Class processor minimum, 1 
GHZ or better recommended  

For information about the features of the full version of PowerDB please visit 
our website at www.powerdb.com.  Get acquainted with the following features 
by scheduling a live demonstration at info@powerdb.com 

 Synchronize All of Your Test Records Into a Single Corporate 
Database 

 Reduce Test Time 
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 Improve Data Integrity 

 Standardize Test Procedures 

 Easily Use Historical Trending for Evaluation of Test Results 

 Eliminates the Need to Install and Maintain a Software Application 
per Instrument 

 Eliminates All Hand Written Test Sheets 

 Create Your Own Test Forms 

 Use or Modify One of Our 200 Built-in Test Forms 

 One Step Procedure To Generate Test Reports With Table of 
 Contents and Deficiency Summaries 

 Allows All Of Your Field Test Data To Be Integrated With CMMS 
Systems Such As Maximo or SAP 

 Imports >From Many Other Industry Standard Software 
Applications 

 Controls and Imports Data From Many non-Megger Instruments 

 



 
PowerDB Lite 
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Software Installation 

To install PowerDB Lite, load the PowerDB Lite CD into your CD-ROM drive 
and follow the on-screen instructions.   

5. Accept the terms of the License agreement.   

 

6. Choose the destination location for the PowerDB Lite files. 
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7. Select Default Settings.   

 

8. InstallShield Wizard will complete the installation of PowerDB Lite.  Click 
Finish to close the installation program. 

 



 
PowerDB Lite 
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Using PowerDB Lite  

1. Home 

1.  Select your Instrument from the Instrument Setup screen.   

a. You can always view the Instrument Setup screen from the Tools 
menu or F3.   

b. Select the appropriate row in the Description column. 
Then click the “...” button in the Setup column.  

 

c. The TTR 300/310 only uses serial communicate, so never check ‘Use 
Ethernet’ if you are using a TTR 300 or TTR 310. Select the 
appropriate communication settings on the Serial Device 
Configuration screen.  Use the Refresh button to find any ports that 
may have not been connected at the startup of PowerDB Lite.  If you 
are using a USB serial port and do not know the port assigned to it 
please perform the following: 

1. Remove the USB serial adapter 

2. Press Refresh 

3. Click on the port drop down and record the options 

4. Plug the adapter back in 

5. Press refresh 
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6. Select the port that was not in the original list 

Verify that the baud rate is set to 9600, Parity is set to none, Byte Size is set to 8, 
and Stop Bits is set to 1.   

d. Only check ‘Use Ethernet’ if connected to the TTR330.  If you leave 
the IP address blank PowerDB Lite will discover the unit.  If you 
have problems with the discovery enter the IP address which is 
displayed on the instrument’s Preferences screen.   

 

e. Then Click OK on the Instrument Setup Screen to finish.   

2. Open a New Form 

a. Select the File>New menu item, or type CTRL+N, or press the New 
toolbar button. 

b. The forms associated with the detected instrument will be shown in 
the Select a Form screen.   

c. Choose a form by double-clicking or by navigating with the arrow 
keys and pressing the OK key. 

d. See Specific Form Help Instructions for further instruction on test 
steps.  You can view the Form Help by pressing the F1 key once the 
form is loaded. 
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3. Enter Test Data 

a. Header and nameplate information can be manually typed into a 
form. 

b. Click the Initialize Instrument button   to initialize the test set.   

c. Form fields with automation will now be colored cyan. Right-clicking 
these fields will start the test. 
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d. To change the settings of the TTR place the mouse on the form and 
right-click.  Then select “TTR Settings”. 

 

e. This dialog box allows you to change the TTR settings.  The settings 
that can be changed are as follows: 

 
1.  Show Diagram Number 

When enabled this will display a numeric field below the 
winding configuration diagram on the form.  The diagram 
can then be changed by entering a number in this field. 

2.  Standard 

This enables you to choose between the ANSI, Australian, or 
IEC Standard.  

3.  Test Voltage 

This enables you to choose the test voltage at which the test 
is run.  Auto allows the instrument to choose an acceptable 
test voltage for testing.  You may choose between Auto, 8, 
40, or 80.   

4. Running an Automated Test 

a. Select the Initialize Instrument button.    

b. Automated fields should now turn cyan colored. 

c. Right-click on the cyan colored fields. 

d. Follow the on screen instructions specific to the test. 
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5. Comments and Deficiencies 

When imported into the full version of PowerDB, the comments and 
deficiencies on each form are used to generate summary reports.  These 
summary reports repeat the notations and lists the page number where reported.  
This allows the user to scroll to a particular page to view a reported anomaly.  
For more information on features of PowerDB visit us at our website at 
www.PowerDB.com.  

6.  Save the Data 

a. Select the File>Save menu item, or press CTRL+S, or press the Save 
toolbar button. 

b. The Save As screen will allow you to specify a location and file name 
for your PowerDB Lite XML file.  
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 7. Opening an Existing File 

a. Select the File> Open menu item. 

 

b. Browse to the file you would like to open. 

c. Press the Open dialog button. 

d. d.   If the file contains multiple test dates, select the date that you 
would like to open for editing or select New to append a new set of 
results to the file.  To remove a set of results, click on the selected file 
and press the delete button.   
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8. Loading Data Files 

When testing with the TTR 320 or TTR 330 you may load files saved on the 
instrument’s USB drive.  Refer to Step 7 for instructions on selecting and 
opening files. 

9. Setting the Logos 

a. Select the Tools>Options menu item.   

b. The Logos section specifies paths to the left and right logos files to 
use.  

c. To change the left logo press the “…” button by the left logo path. 

d. The Open screen allows you to browse to a file location, select a 
.JPG or .BMP file, and press the Open button.   

e. Repeat steps (c) and (d) for the right logo path.   

f. Note that a logo will not be shown if the logo file path is blank or the 
file does not exist. 

g. Note after specifying the logo files the image will not be shown until 
the next time a form is opened (File>Open, or the File>New menu 
items). 

h. Note that the logos will look the best if the resolution of the file is 
pixels wide by 240 pixels high.  DPI is not important. 
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10. How to change Languages 

a. Select the Tools>Options menu item. 

b. Select the appropriate language in the dropdown menu.   

 

11. How to change units of measurement 

a. Select the Tools> Options menu item. 

b.  Select the units in the drop down Default Units under Measurements 

.   
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12. Additional Notes 

a. Additional forms can be filled out by repeating steps 2, 3 and 6. 

b. Forms can be printed with the File>Print menu item, or type 
CTRL+P, or press the Print toolbar button.   

c. A help guide may be found in the Help>PowerDB Lite Help menu 
item.   

Frequently Asked Questions (FAQ’s) 
1. Can I change the forms? 

No.  You must have the full version of PowerDB to change forms.  

2. Can I synchronize forms to a database? 

No.  You must have the full version of PowerDB for database support and to 
synchronize multiple field databases to a single master database. 

3. Can I import PowerDB Lite files into PowerDB? 

Yes.  You can use the File>Import menu item in PowerDB to import files from 
PowerDB Lite.   
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Specific Form Help Instructions 

Operating Instructions for the Multiple Quick Test Form 

a. Type in the asset ID and then press the Enter key. 

b. Use the left and right arrow keys to select the high-side winding 
configuration. 

c. Press the Enter or Tab key. 

d. Use the left and right arrow keys to select the low-side winding 
configuration 

e. Press the Enter or Tab key. 

f. Select the test voltage from the dropdown menu, then press Enter or 
Tab. 

g. Type in the high side tap number and press the Enter key. 

h. Type in the high side voltage and press the Enter key. 

i. Type in the low side tap number and press the Enter key. 

j. Type in the low side voltage and press the TEST key (F2) or right 
click on the blue highlighted fields. 

k. Hit the Enter key and repeat for each tap you would like to test.   
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Operating Instructions for the Simple 3PH TTR Form 

This form can be used for testing a two or three winding transformer with 
multiple taps on one or more of the windings.  

If you are testing a three winding transformer please check the “Has Tertiary” 
checkbox.  

Next select the winding configuration by using the left and right arrow keys.  
Press the Enter or Tab key to move to the next field. 

The default total number of tests is defined as follows: 

1. Test for each secondary (or tertiary) tap tested with the primary nominal tap. 

2. Test for each primary tap with the nominal secondary (or tertiary) tap. 

If you do not wish to test all of the secondary or tertiary taps you can reduce the 
“# tests” field for each category of tests (primary, secondary, tertiary). 

Once the total number of taps and the # tests field are entered the form will 
display the correct number of rows to perform testing. 

Once the voltage is entered for the first and last tap values (from the 
transformer’s nameplate tap voltage table), the ratios for all taps will 
automatically be calculated and populated.  Please note that the calculated values 
can be over written.   

Right click on each of the blue highlighted fields in each table to run the tests. 
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Operating Instructions for the 3PH TTR with TAP Changer Form 

The procedure for this form is the same as the Simple TTR form.  The only 
difference is that it allows the user to enter additional nameplate information. 
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8 
Service 

Maintenance 
Maintenance should be performed only by qualified persons familiar with the 
hazards involved with high-voltage test equipment. Read and understand Section 
2, Safety, before performing any service.  

The TTR310 test set is sturdily constructed and requires no periodic 
maintenance. Routine maintenance is all that is required for the TTR310 test sets. 
Inspect the cable assemblies occasionally to ensure they are in good condition. 

The appearance of the TTR310 test set can be maintained by occasionally 
cleaning the case, panel and cable assemblies. Clean the outside of the carrying 
case with detergent and water. Dry with a clean, dry cloth. Clean the control 
panel with a cloth dampened with detergent and water. Do not allow water to 
penetrate panel holes, because damage to components on the underside may 
result. An all-purpose, household spray cleaner can be used to clean the panel. 
Polish with a soft, dry cloth, taking care not to scratch the display screen cover. 
Clean the cables and mating panel receptacles with isopropyl or denatured 
alcohol applied with a clean cloth. 

Fuse Replacement 

The electronic circuits in the TTR310 test set are protected by two mains fuses. 
Fuse replacement is indicated if the electronic circuits do not function. Refer fuse 
replacement to qualified personnel. To avoid electric shock and fire hazard, use 
only the fuses specified in Section 3, Specifications, that are identical in respect 
to type, voltage rating, and current rating. Note that 2 spare fuses are included 
with each TTR310. 

WARNING 
Before replacing the fuses, disconnect the power input 
plug from the live power source. 
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To replace fuse(s), proceed as follows: 

1. Disconnect the power cord from the TTR310 test set. 

2. Using a small flathead screwdriver, carefully pry out the fuse holder of the 
input power module installed on the right side of the TTR310 test set front 
panel. 

3. Remove and properly dispose of spent fuse(s). 

4. Install new fuse(s) making sure to use the type specified in Section 3. 

5. Reinstall the fuse holder in its receptacle in the input power module. Connect 
the power cord to the TTR310 test set and to an energized power source. If 
the electronic circuits still do not function properly, contact the factory for 
service. 

Calibration 

A complete performance and calibration check should be made at least once 
every year. This will ensure that the TTR310 test set is functioning and calibrated 
properly over the entire measurement range. The 3-phase TTR310 calibration is 
performed on each new or repaired unit before sending it to a customer. There is 
a special 3-phase TTR310 final calibration procedure which requires a NIST-
traceable test equipment to be used. As a result of such calibration procedure, 
each TTR310 test set may be NIST certified.  

To check the 3-phase TTR310 calibration at a customer site or in the field, the 
Megger Calibration Standard Cat.No550055 or equivalent standard should be 
used. To perform a quick simplified calibration check, the Megger Calibration 
Standard CatNo550555 may be used. The last standard has eleven switchable 
turns ratio settings which cover the turns ratio range from 1:1 to 2000:1. Using 
these Calibration Standards will confirm proper calibration of TTR310 test set. 
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3-Phase TTR310 Test Set  Functional Test 

A customer may want to make sure that the test set is functioning properly 
before testing a transformer. Traditionally, for the transformer turns ratio testers, 
a customer performed this test by connecting H1-X1 and H2-X2 test leads. The 
1:1 turns ratio was expected to be measured. Additionally, the displayed test 
results were interpreted as a test set calibration check.  

The 3-phase TTR310 test set is designed and optimized for the transformer turns 
ratio testing. It uses a mixed analog-digital technique to provide the high accurate 
readings of the tested transformer turns ratio. The test set measurement 
approach is based on high impedance input and output transformer voltage 
monitoring circuits. The high impedance of the monitoring circuits is optimized 
for the accurate transformer turns ratio testing.  

When performing a 3-phase TTR310 functional test, the H and X test leads 
interconnect the input and output monitoring circuits without a transformer 
being connected. Such connection cause an impedance mismatch and, as a result 
of the mismatch, the displayed turns ratio reading is not exactly 1:1 as it may be 
expected. A customer should be aware that a functional test is not a real 
transformer turns ratio test. Due to the intrinsic and inevitable impedance 
mismatching, the 3-phase TTR310 functional test readings may be from 0.9980 
to 1.0020. The TTR310 functional test readings do not represent its calibration. 
It simply shows that the TTR310 test set circuitry functions properly. To check 
the 3-phase TTR310 calibration, a customer should use the Calibration Standards 
mentioned in Calibration section of the manual. 

To perform a 3-phase TTR310 functional test proceed as follows: 

1. Turn TTR310 test set power off. 

2. Connect H1 lead to X1 lead, H2 lead to X2 lead, H3 lead to X3 lead, and H0 
lead to X0 lead. Make sure the leads are properly connected. 

3. Turn TTR310 test set power on. 

4. After self-test is complete and the main menu screens appear, select 4, and 
then select 4 and enter 80 V. On the same menu select 6. 

5. When the Main menu appears, select 1. 

6. When the Quick test setup menu appears, select 2 and enter 7. The 
transformer type entry displays DIAG 07 YNyn0. 
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WARNING  
Do not continue functional test if the QUICK TEST SETUP 
menu does not display DIAG 07 YNyn0 transformer type.  
Keep the leads, which are energized, clear of ground, and 
personnel. 

7. Select 3, START TEST on QUICK TEST SETUP menu. 

8. The readings for phases A, B, and C should be: 

RATIO: 1.0000 ±0.0020 

PHASE(min): 0 ±5 

Iexc (mA): 0.0 to 0.5 

If needed, perform the test according to steps 1 through 8 for the excitation 
voltage 40 V, and then for the excitation voltage 8 V. The readings should be the 
same as shown in step 8. 
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Troubleshooting 

The Troubleshooting Guide, Table 7-1, is arranged to help you evaluate the 
reasons for TTR310 test set malfunction. The table lists possible test set 
malfunctions which may be encountered during operation and lists possible 
causes. Electronic circuit repairs should not be attempted in the field. Refer to 
Repair section. Refer to Section 8 for a list of spare parts. 

Table 7-1. Troubleshooting Guide 
MALFUNCTION POSSIBLE CAUSE 

Display stays blank after POWER switch is turned 
on. 

 No service power. 
 Defective line cord. 
 Defective fuse(s). 
 CONTRAST potentiometer not adjusted. 
 Defective display or electronics. 

Error message: 
ANALOG OFFSET VOLTAGE HIGH 
and/or 
ANALOG GAIN OUT OF TOLERANCE 
appears after self-test is complete.  

Out of tolerance condition(s) in measurement 
circuit. 

Red TEST VOLTAGE ON lamp does not light on 
start of testing. 

 Defective lamp. 
 EMERGENCY TEST OFF switch is not 

released. 
 Problem in measuring circuit. 

One of the following messages appear on the test 
result screen. 

 CHECK CONNECTIONS 
 PHASE A (or B, or C) EXCITATION 

CURRENT TOO HIGH; 
 TURNS RATIO TOO LOW, <0.8; or 

PHASE A (or B, or C) TURNS RATIO 
TOO HIGH; 

 CHECK PHASE A (or B, or C) 
CONNECTIONS, REVERSED; 

 CHECK PHASE A (or B, or C) 
POLARITY  

 Abnormal operating condition. 
 Incorrect setting of TRANSFORMER TYPE in 

the quick test setup or the full test setup 1 
menus. 

 Incorrect connection of leads. 
 Defective test leads. 
 Incorrect marking of a transformer. 
 Problem in test specimen. 
 Problem in measuring circuit. 

RATIO and/or Iexc (mA) readings erratic. 

 Defective test leads (open circuit, poor 
connection). 

 Severe abnormal transient in service power. 
 Problem in test specimen (poor connection). 
 Problem in measuring circuit. 

Cannot obtain printout when printer is connected. 
 Printer power not turned on. 
 Printer battery discharged. 
 Problem in measuring circuitry. 
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Repair 

Megger offers a complete repair and calibration service and recommends that its 
customers take advantage of this service in the event of equipment malfunction. 
Contact your MEGGER representative for instructions and a return 
authorization (RA) number. Equipment returned for repair should be shipped 
prepaid and insured and marked for the attention of the Repair Department. 
Please indicate all pertinent information including problem symptoms and 
attempted repairs. The catalog number and serial number of the test set should 
also be specified. Pack the TTR310 test set, including all cables, in a carton 
(original shipping carton if available) with adequate dunnage in accordance with 
best commercial practice. Seal the carton with waterproof tape.  

 

Ship to: M 

   Valley Forge Corporate Center 
   2621 Van Buren Avenue 
   Norristown, PA 19403 U.S.A. 
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Glossary 

 

 
Use only in accordance with instruction manual. 
 
 

 
 

Protective ground (earth) terminal is the wing nut for connecting the test 
set to earth ground. 

ANSI  American National Standards Institute 

BCT Bushing current transformer 

CEI/IEC The initials of the official French name, Commission Electrotechnique 
Internationale, of the International Electrotechnical Commission. 

Centiradian Phase display option in SYSTEM SETUP screen. 1 centiradian = 
0.573 degrees. 

CT Current transformer 

LCD Liquid crystal display 

LTC Load tap changer. A selector switch device used to change transformer 
taps with the transformer energized and carrying full load. 

Safety ground 
stick 

An insulated stick (sometimes called a hot stick) with a hook type 
electrode connected to ground via an insulated cable. In some 
discharge sticks, a resistor is connected between the electrode and the 
ground cable. Both are used to discharge capacitive specimens by 
providing a low-impedance path to ground. They must be suitable 
rated for the voltage and capacitance of the specimen to be discharged.

transient A change in the steady-state condition of voltage or current, or both. 

TTR Transformer turn ratio; a registered trademark of Megger. 

turn ratio The ratio of the number of turns in a higher voltage winding to that in 
a lower voltage winding. 
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OPERATIONAL FLOW CHART, 15 
OPTIONAL ACCESSORIES, 11 
OPTIONAL INVERTER, USE, 92 

P 
PHASE A TEST RESULT, 81 
PRINCIPLE OF OPERATION, 13 
PRINTER, USE WITH OPTIONAL, 90 
PRINTOUT, SAMPLE, 91 

Q 
QUICK TEST RESULT SCREEN, FINAL, 73 
QUICK TEST RESULT SCREEN, INITIAL, 72 
QUICK TEST SETUP SCREEN, 71 

R 
RECALL (OR SAVE) CUSTOM TRANSFORMER SETTINGS, 87 
RECEIVING INSTRUCTIONS, 1 
REMOTE CONTROL OPERATION, 89 
REMOTE CONTROL OPERATION FOR LTC TESTING, 89 
REPAIR, 116 
ROUTINE MAINTENANCE, 111 
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S 
SAFETY, 3 
SAMPLE PRINTOUT OF TEST REPORT, 91 
SAVED DATA SCREEN, 86 
SCREENS 

Full Test Setup 1, 74 
Full Test Setup 2, 76 
Full Test Setup 3, 78 
Language, 85 
Main menu, 69 
Main Menu Screen After Selection of a Custom Transformer Setting, 83 
Opening Display, 68 
Phase A Rest Result, 81 
Quick Test Result, Final, 73 
Quick Test Result, Initial, 72 
Quick Test Setup, 71 
Recall (or Save) Custom Settings, 87 
Saved Data, 86 
System Setup, 84 
Transformer Test Result, 80 

SERVICE, 116 
SETUP AND CONNECTIONS, 21 
SPECIFICATIONS, 7 

Electrical, 7 
Environmental Conditions, 10 

SYSTEM SETUP SCREEN, 84 

T 
TAP FORMULA, % DIFFERENCE/TAP, 75, 77 
TEST LEAD MARKINGS 

Single-phase Transformers, 23 
Three-phase Transformers, 25 

TRANSFORMER TEST RESULT SCREENS, 80 
TRANSFORMER WINDING PHASE RELATIONSHIP 

ANSI, 39 
Australian Standard 2374, Part 4 - 1982, 61 
CEI/IEC 76-1, 1993, 48, 50 
T-type, 33 

TROUBLESHOOTING, 115 
TROUBLESHOOTING GUIDE, 115 
TTR BUTTON, IV 
T-TYPE TRANSFORMERS, 33 

U 
USE WITH THE OPTIONAL INVERTER, 92 
USE WITH THE OPTIONAL PRINTER, 90 

V 
VECTOR VOLTAGE DIAGRAMS, 34 
VOLTAGE REGULATORS, SETUP FOR TESTING, 23, 24 
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W 
WARNING, 21, 25, 26, 27, 111, 114 
WEIGHT, 10 
 


